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Prefazione

La nostra Compagnia
Fondata nel 2011, Elegoo Inc. è una fiorente società che si occupa di tecnologia 

dedicata alla ricerca e sviluppo, produzione e commercializzazione di hardware open- 

source. Situati a Shenzhen, la Silicon Valley della Cina, siamo cresciuti fino ad avere 

più di 150 dipendenti con più di 1.000 metri quadrati di fabbrica. 

Le nostre linee di prodotti variano tra fili di DuPont, schede UNO R3, fino a starter kit 

pensati per clienti di qualsiasi livello interessati ad imparare e migliorarsi con Arduino. 

Vendiamo inoltre di accessori per Raspberry Pi come schermo 2.8'' TFT touch e 

STM32. In futuro vorremmo dedicare più energia e gli investimenti per le stampanti 

3D e simili. Tutti i nostri prodotti seguono le norme internazionali di qualità e sono 

molto apprezzati in una grande varietà di mercati in tutto il mondo. 

Sito ufficiale: http://www.elegoo.com 

US Amazon storefront: http://www.amazon.com/shops/A2WWHQ25ENKVJ1 

CA Amazon storefront: http://www.amazon.ca/shops/A2WWHQ25ENKVJ1 

UK Amazon storefront: http://www.amazon.co.uk/shops/AZF7WYXU5ZANW

DE Amazon storefront: http://www.amazon.de/shops/AZF7WYXU5ZANW 

FR Amazon storefront: http://www.amazon.fr/shops/AZF7WYXU5ZANW

ES Amazon storefront: http://www.amazon.es/shops/AZF7WYXU5ZANW

IT Amazon storefront: http://www.amazon.it/shops/AZF7WYXU5ZANW



3 / 167

Il nostro Tutorial
Questo Tutorial è stato progettato per i principianti. Imparerete tutte le nozioni di 

base su come utilizzare il controllore Arduino, sensori e componenti. Se volete 

studiare Arduino in modo più approfondito, vi consigliamo di leggere “Arduino 

Cookbook” scritto da Michael Margolis. 

Alcuni codici in questo tutorial sono a cura di Simon Monk. Simon Monk è autore di 

una serie di libri relativi all'Open Source Hardware. Sono disponibili su Amazon: 

“Programming Arduino”, “30 Arduino Projects for the Evil Genius” e “Programming 

the Raspberry Pi”. 

Assistenza Clienti
Essendo un’azienda di tecnologia siamo in costante e veloce crescita, continuando a 

fare del nostro meglio per offrire eccellenti prodotti e servizi di qualità. Per soddisfare 

le vostre aspettative e potete mettervi in contatto con noi semplicemente scrivendo 

a service@elegoo.com o EUservice@elegoo.com. Saremo molto felici di avere vostri 

commenti, critiche e suggerimento. Avrete risposta a tutte le vostre domande e ai 

vostri eventuali problemi entro 12 ore (24 ore durante le vacanze) 
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Lezione 0 Installazione IDE 
 
 

Introduzione 

"Arduino Integrated Development Environment", IDE o Ambiente di Sviluppo 

Integrato è il lato software della piattaforma Arduino. 

In questa lezione imparerai come configurare il computer per utilizzare Arduino e 

come impostarlo per le lezioni che seguono. 

Il software di Arduino che verrà utilizzato per programmare la piattaforma Arduino 

è disponibile per Windows, Mac e Linux. Il processo di installazione è diverso per le 

tre piattaforme e purtroppo necessita di una certa quantità di lavoro manuale per 

essere installato 

 
 
 

STEP 1: Visita https://www.arduino.cc/en/Main/Software e troverai la seguente 

schermata. 
 

 

 

La versione disponibile sul sito è la più recente, potrebbe non corrispondere a quella 

in foto qui sopra. 
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STEP2：Scarica il software di sviluppo che è compatibile con il sistema operativo del 

computer. In questo esempio utilizzeremo Windows. 
 
 

 

 

Clicca su Windows Installer. 
 
 

 

 
Premi su JUST DOWNLOAD. 
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La versione 1.8.0 è disponibile anche nel materiale che ti abbiamo fornito. 

Nota: Quando è stato scritto questo tutorial la 1.8.0 era la versione più recente 

esistente. 
 

 

 
 

Installazione Arduino (Windows) 

Installa Arduino con il pacchetto di installazione exe. 
 

 

 
 

 

Premi su I Agree(Accetto) per proseguire con la prossima interfaccia. 



 

 

 

Premi su Next(Avanti) 
 

 

Puoi premere su Browse(Naviga)… per scegliere il percorso di installazione o 

digitare direttamente la cartella che vuoi utilizzare. 
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Premi su Install(installa) per dare via al processo di installazione. 
 

 

Al termine, apparirà la seguente interfaccia, premi su Install(installa) per avviare 

l’ultimo passaggio dell’installazione. 
 

 

Successivamente, verrà visualizzata la seguente icona sul desktop. 
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Fare doppio clic sull’icona per accedere all'ambiente di sviluppo. 
 

 

 
 

Puoi scegliere direttamente il pacchetto di installazione e passare direttamente alla 

sezione successive, saltando I prossimi passaggi. Se invece vuoi imparare alcuni 

metodi diversi per installare l’IDE continua a leggere questa sezione. 
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Decomprimi il file zip scaricato, fai doppio clic su “Arduino.exe” per aprire il 

programma ed accedere all'ambiente di sviluppo di Arduino. 
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Tuttavia, questo metodo di installazione richiede l'installazione separata di driver. 

La cartella Arduino contiene sia il programma di sviluppo Arduino sia i driver che 

permettono ad Arduino di interagire con il computer tramite un cavo USB. 

Prima di lanciare il software di Arduino, ricordati di installare i driver USB come 

spiegato nei passaggi seguenti: 

Collega un'estremità del cavo USB alla scheda Arduino e l'altra in una presa USB del 

computer. Si accenderà la spia LED di alimentazione della scheda Arduino e potresti 

visualizzare sul pc un messaggio simile a “Trovato nuovo hardware”. Ignora il 

messaggio e annulla tutti gli eventuali tentativi di Windows di installazione 

automatica dei driver di Arduino. 

Il metodo più affidabile per installare dei driver USB è quello di utilizzare Gestione 

periferiche. Per accedere al pannello di Gestione Risorse sono possibili modi diversi 

a seconda della versione di Windows. 
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Fai   clic   con   il   tasto   destro   del   mouse   sul   dispositivo   e   seleziona   l'opzione 
(Aggiornamento software driver...). 

In Windows 7, è necessario innanzitutto aprire il Pannello di controllo, quindi 

selezionare l'opzione di visualizzazione per icone, e cliccare poi su Gestione 

periferiche nell'elenco. 

Sotto "altri dispositivi", troverai 'periferica sconosciuta' con un piccolo triangolo di 

avvertimento giallo sull’icona. Questa è l’icona relativa al tuo Arduino. 
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Ti Verrà quindi chiesto di scegliere tra 'Cerca automaticamente un driver aggiornato' o 
'Cerca sul computer il software del driver'. Selezionare l'opzione per cercare il driver 
sul pc e navigare fino alla cartella scaricata in precedenza    X:\ arduino1.8.0 \ drivers. 

 
 

 

 
Fare clic su 'Avanti' e verrà visualizzato un avviso di protezione, consentire al 

software di proseguire con l’installazione. Una volta che il software sarà stato 

installato, visualizzerai un messaggio di conferma. 
 

 



 

Gli utenti Windows possono saltare le istruzioni di installazione per i sistemi Mac 

e Linux ed andare direttamente alla Lezione 1. 

Gli utenti Mac e Linux possono continuare a leggere questa sezione. 
 
 
 

Installazione Arduino (Mac OS X) 

Scarica e decomprimi il file zip, fai doppio clic su Arduino.app per accedere all’IDE di 

Arduino. Il sistema ti chiederà di installare la libreria di runtime Java se non la hai 

già installata nel tuo computer. Una volta completata l'installazione ti sarà possibile 

eseguire l’IDE di Arduino. 
 

 

 
 
 

Installazione Arduino (Linux) 

Dovrai utilizzare il comando make install. Se utilizzi il sistema Ubuntu, ti consigliamo di installare 

Arduino IDE dal centro software di Ubuntu. 
 

 

 
 

TIPS: In caso di problemi nell'installazione dei driver, si prega di fare riferimento 

alla ONU R3, UNO, NANO DRIVER FAQ. 
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Lezione 1 Aggiunta delle librerie e apertura della porta seriale 
 

Installare Ulteriori Librerie Arduino 

Una volta che avrai preso dimestichezza con il software di Arduino e utilizzato le 

funzioni di base, ti consigliamo di potenziare le capacità del tuo Arduino con librerie 

aggiuntive. 

 

Cosa sono le librerie? 

Le librerie sono delle raccolte di codici già scritti che rendono facile ed intuitivo il 

l’utilizzo di sensori, la visualizzazione dei dati, ecc. Ad esempio, la libreria 

incorporata LiquidCrystal rende molto semplice la comunicazione tra la scheda 

Arduino e il modulo display LCD. Ci sono centinaia di librerie disponibili per il 

download su Internet. Le librerie integrate e alcune di queste librerie aggiuntive 

verranno utilizzate in questi tutorial. Per utilizzare le librerie aggiuntive, è necessario 

che vengano installate. 

 
Come installare una libreria 

Utilizzando il gestore di librerie. 

Per installare una nuova libreria nel tuo ambiente di sviluppo Arduino dovrai 

utilizzare il Gestore librerie (disponibile da IDE versione 1.8.0). Aprire l'IDE e fare clic 

sul menu "Sketch" e poi: “Include Library” > “Manage Libraries”. 
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A questo punto si aprirà il gestore delle librerie e troverai un elenco di librerie già 

installate o pronte per l'installazione. 

In questo esempio installeremo la libreria Bridge. Scorri l'elenco per trovarla, quindi 

seleziona la versione della libreria che vuoi installare. A volte solo una versione della 

libreria è disponibile. Se non viene visualizzato il menu di selezione della versione, 

non preoccuparti: è normale. 

Capita di dover essere pazienti con il gestore di librerie, proprio come mostrato in figura. 
 

 

Clicca su aggiorna e attendi. 
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Infine, fare clic su installa e attendi che l'IDE installi la nuova libreria. Il download 

può richiedere del tempo a seconda della velocità di connessione. Una volta finita, 

il tag “INSTALLED” dovrebbe comparire accanto alla libreria Bridge. Puoi ora 

chiudere la gestione delle librerie. 
 

 

 
 
 

Ora ti sarà possibile trovare la nuova libreria disponibile nel menu: Library. 

Se vuoi aggiungere una tua libreria all’elenco delle librerie disponibili in questa 

raccolta puoi fare una richiesta sull’apposita repository di Github. 

 
Importare una libreria in format .zip 

Le librerie sono spesso distribuite come file ZIP o come cartelle. Il nome della cartella 

è il nome della libreria. All'interno della cartella ci sarà un file .cpp, un file .h e spesso 

un file keywords.txt, la cartella con gli esempi, e altri file richiesti dalla libreria. A 

partire dalla versione 1.0.5, è possibile installare le librerie di terze parti nell'IDE. 

Non è necessario decomprimere le librerie zip scaricate, lasciarle così come sono. 

Nel IDE di Arduino, navigare in Sketch > Include Library. Nella parte superiore del 

menu a tendina e selezionare l'opzione "Add .ZIP Library''. 
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23 / 16 

 

 

 

Ti verrà richiesto di selezionare la libreria che desideri aggiungere. Navigare fino alla 

posizione del file .zip scelto e aprirlo. 
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Torna al menu Sketch> Import Library. Ora dovresti vedere la libreria in fondo al 

menu a tendina. Ora è pronta per essere utilizzata nel vostro codice. 

Il file zip sarà stato decompresso nella cartella library di Arduino. 

NB: la libreria sarà disponibile da utilizzare, ma gli esempi per la libreria non saranno 

visibili in File> Esempi fino a che l'IDE sarà riavviato. 

Quei due sono I metodi più comuni. i sistemi Mac e Linux possono essere gestiti allo 

stesso modo. L'installazione manuale che verrà introdotta qui di seguito può essere 

utile in alcuni rari casi e se non ne vedi la necessità puoi saltare il seguente paragrafo. 

 

Installazione manuale 

Per installare la libreria, prima chiudere l'applicazione Arduino. Poi decomprimere il 

file ZIP contenente la libreria. Ad esempio, se si sta installando una libreria chiamata 
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"ArduinoParty", decomprimere ArduinoParty.zip. Dovrebbe contenere una cartella 

chiamata ArduinoParty, contenente i file di cui si parlava al paragrafo sopra 

ArduinoParty.cpp e ArduinoParty.h. (Se i file cpp e .h non sono in una cartella, è 

necessario crearne una. In questo caso, devi creare una cartella chiamata 

"ArduinoParty" e spostare in essa tutti i file che erano nel file ZIP: ArduinoParty.cpp, 

ArduinoParty.h, etc.) 

Trascinare la cartella ArduinoParty in nella tua cartella delle librerie. In Windows, la 

troverai probabilmente nel percorso "My Documents \ Arduino \ libraries". Per gli 

utenti Mac, troverai probabilmente nel percorso "Documenti / Arduino / librerie". 

Su Linux, troverai la cartella "library" nel tuo sketchbook . 

 
La cartella library di Arduino dovrebbe apparire così (su Windows): 

My Documents\Arduino\libraries\ArduinoParty\ArduinoParty.cpp 

My Documents\Arduino\libraries\ArduinoParty\ArduinoParty.h 

My Documents\Arduino\libraries\ArduinoParty\examples 

O così (su Mac e Linux): 

Documents/Arduino/libraries/ArduinoParty/ArduinoParty.cpp 

Documents/Arduino/libraries/ArduinoParty/ArduinoParty.h 

Documents/Arduino/libraries/ArduinoParty/examples 

.... 
 
 

Ci potrebbero essere più file oltre ai soliti .cpp e .h, l’importante è assicurarsi che 

siano tutti lì. (La library non funziona se si mette I file cpp e .h direttamente nella 

cartella library o se sono annidati in una cartella di troppo. Ad esempio: Documents 

\ Arduino \ libraries \ ArduinoParty.cpp e Documents \ Arduino \ le librerie \ 

ArduinoParty \ ArduinoParty \ ArduinoParty.cpp non funzioneranno.) 

Riavviare l'applicazione Arduino. Assicurarsi che la nuova libreria compaia nel menu 

di Sketch->Import Library del software. Questo è tutto! Hai installato una libreria! 

 

Arduino Serial Monitor (Windows, Mac, Linux) 

L’ambiente integrato di sviluppo (IDE) di Arduino è il lato software della piattaforma 

Arduino. E dato che l'utilizzo del terminale è una grossa fetta del lavoro con Arduino 

e altri microcontrollori, gli sviluppatori hanno deciso di includere un terminale 
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seriale nel software. All'interno dell'IDE di Arduino, questo terminale è chiamato il 

Serial Monitor. 

 

Connettersi al Monitor Seriale 

Il Monitor Seriale è presente di ogni versione di Arduino. Per aprirlo, è sufficiente 

fare clic sull'icona del monitor seriale, come da immagine sottostante. 
 

 

Nello stesso modo in cui si seleziona una porta per il caricamento di codice Arduino, 

si sceglie quale porta aprire nel Serial Monitor. Andare in Tools -> Serial Port, e 

selezionare la porta corretta. 

 
Consiglio: scegli la stessa porta COM che hai trovato in precedenza in Gestione 

periferiche. 
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Una volta aperto dovresti vedere qualcosa di simile: 
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Impostazioni 

Il Serial Monitor ha impostazioni limitate, ma sufficienti per gestire la maggior parte 

delle esigenze di comunicazione seriale. La prima impostazione modificabile è la 

velocità di trasmissione. Fai clic sul menu a discesa e seleziona la velocità di 

trasmissione corretta. (9600 baud) 

 

Infine puoi scegliere se impostare l’Autoscroll o meno utilizzando la checkbox 

nell’angolo in basso a sinistra 
 

 

 
Pro 

Il Serial Monitor è un modo ottimo, rapido e semplice per stabilire una connessione 

seriale con Arduino. Se si sta già lavorando in Arduino, non c'è alcun bisogno di 

aprire un terminale separato per visualizzare i dati. 

Contro 

La mancanza di impostazioni lascia molto a desiderare nel Serial Monitor, e, per le 

comunicazioni seriali avanzate, potrebbe non essere abbastanza. 
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Lezione 2 Lampeggio (Blink) 
 
 

Introduzione 

In questa lezione imparerai come programmare il tuo UNO R£ per far lampeggiare 

il LED già presente sulla scheda e come scaricare il programma in piccoli passi. 

 

Componenti Richiesti: 

(1)  x Elegoo UNO R3 
 
 

Informazioni di Base 
 

 

La scheda UNO R3 ha linee di connettori lungo i tre lati che vengono utilizzati per la 

connessione  a  vari  dispositivi  elettronici  e  schede  “shield”  che  estendono  le  sue 

capacità. 

La  scheda  ha  anche  un  LED  che  è  possibile  controllare  direttamente  dal  codice. 

Questo LED è situato in alto a sinistra sulla scheda UNO R3 ed è spesso indicato con 

il simbolo 'L' LED come quello cerchiato sull’immagine sottostante. 

Potresti notare che la tua scheda UNO R3 abbia il led 'L' già lampeggiante quando la 

colleghi ad una presa USB. Questo perché le schede sono in genere fornite con il 

codice 'Blink' pre-installato. 
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In questa lezione, riprogrammerai la scheda UNO R3 con il nostro codice Blink e 

quindi potrai modificare la velocità con cui il LED lampeggia. 

Nella lezione 0, hai impostato l’IDE di Arduino e hai fatto in modo di impostare la 

porta seriale giusta per poter collegare la tua scheda UNO R3. Ora è il momento di 

mettere alla prova il collegamento e programmare la scheda UNO R3. 

L'IDE di Arduino include una vasta collezione di esempi di codici che è possibile 

caricare e utilizzare. Tra questi vi è un esempio che permette far lampeggiare il LED 

‘L’. 

Carica il codice 'Blink' che trovi nel di menu dell’IDE in File> Esempi> 01.Basics 
 
 

 

Quando si apre la finestra del codice, ingrandirla in modo che si possa vedere l'intero 

codice nella finestra. 
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Gli esempi di codici inclusi con l’IDE di Arduino sono in 'sola lettura'. Cioè, è possibile 

caricarli su una scheda UNO R3, ma se li si cambia, non è possibile salvarli come lo 

stesso file. 

Dal momento che ci accingiamo a cambiare questo codice, la prima cosa che devi 

fare è salvare la tua copia di codice. 

Dal menu File sul Arduino IDE, selezionare 'Salva con nome...' e quindi salvare il 

disegno con il nome di 'MyBlink'. 
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Ora hai salvato la tua copia di 'Blink' nella tua raccolta di codici. Questo significa che 

se tu volessi trovare il tuo codice potresti aprirlo cliccando su File > Open Recent. 
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Collega la tua scheda Arduino al computer con il cavo USB e verifica che 'Board Type' 

e 'Serial Port' siano impostate correttamente, come da screen seguenti. 
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Nota: il tipo scheda e la porta seriale da utilizzare non sono necessariamente le 

stesse mostrate in figura. Se si utilizza UNO, allora si dovrà scegliere UNO come tipo 

di scheda, altre scelte possono essere fatte nello stesso modo. La porta seriale 

visualizzata per ognuno è diversa, nonostante sia stata scelta COM 26 

nell'immagine seguente, la porta corretta sul tuo computer potrebbe essere COM3 

o COM4. Una porta COM giusta dovrebbe essere COMX (Arduino XXX), che soddisfa 

i criteri di certificazione. 

 
La IDE di Arduino vi mostrerà le impostazioni per scheda corrente nella parte 

inferiore della finestra. 
 

 

Fai clic sul pulsante 'Carica'. É il secondo pulsante da sinistra nella barra degli 

strumenti. 

 
 

Se guardi l'area di stato dell'IDE, vedrai una barra di avanzamento e una serie di 

messaggi. In un primo momento, vedrai 'Compilazione Sketch ...'. Questo trasforma 

il codice in un formato adatto per il caricamento sulla scheda. 
 

 

Successivamente, lo stato passerà a 'Caricamento'. A questo punto, i LED su 

Arduino dovrebbero iniziare a lampeggiare mentre il codice viene trasferito sulla 

scheda. 
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Infine, lo stato passerà a 'Fatto'. 
 

 

Il messaggio seguente ci dice che il disegno sta usando 928 byte dei 32,256 byte 

disponibili. Dopo la 'Compiling Sketch..'(compilazione del codice) potresti ottenere 

il seguente messaggio di errore: 
 

 

Può significare che la scheda non sia collegato affatto oppure non siano stati 

installati i driver (se necessari) o che sia stata selezionata la porta seriale sbagliata. 

Se si verifica questo problema, tornare alla Lezione 0 e verificare l'installazione. 

Attendere che il caricamento sia completato, la scheda Arduino dovrebbe riavviarsi 

e iniziano a lampeggiare. 

Apri il codice 

Si noti che una parte enorme di questo codice è composto da commenti. Queste 

non sono istruzioni del programma; Servono semplicemente spiegare come 

funziona il programma. Sono lì per aiutare chi legge il codice. Tutto ciò che si trova 

tra / * e * / nella parte superiore del disegno è un blocco di commento; spiega il a 

cosa serve questo codice. 
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I commenti su una singola riga iniziano con // e tutto ciò che è presente fino fine di 

quella linea è considerato un commento. 

La prima linea di codice è: 

//define led pin 

int led = 13; 

Come il commento di cui sopra spiega, questo comando definisce un nome per il pin 

a cui è collegato il LED. Sulla maggior parte degli Arduino, tra cui UNO e Leonardo, 

è il pin 13. Successivamente, abbiamo la funzione di 'setup'. Di nuovo, come spiega 

il commento, questa funzione viene eseguita quando viene premuto il pulsante di 

reset sulla scheda. Viene eseguito anche ogni volta che avviene il ripristino della 

scheda, per qualsiasi motivo, come per esempio quando viene connesso ad una 

fonte di alimentazione, oppure dopo un nuovo codice viene caricato. 

void setup() { 

// initialize the digital pin as an output. 

pinMode(led, OUTPUT); 

} 

Ogni codice di Arduino deve avere una funzione di 'setup', e la zona corretta dove si 

aggiungono le istruzioni da eseguire durane il setup è proprio tra le due parentesi 

graffe: {...}.In questo caso, vi è un solo comando tra le parentesi, che, come il 

commento spiega, imposta sulla scheda Arduino il pin LED come uscita. É anche 

obbligatorio per il codice di avere una funzione di 'loop'. A differenza della funzione 

di 'setup' che viene eseguito solo una volta, dopo un reset, la funzione di 'loop' sarà 

eseguita dopo aver terminato l'esecuzione del setup, ed una volta terminata andrà 

in loop, cioè verrà ripetuta all'infinito, se non definiamo ulteriori comandi. 

void loop() { 

digitalWrite(led, HIGH); // turn the LED on (HIGH is the voltage level) 

delay(1000);  // wait for a second 

digitalWrite(led, LOW); // turn the LED off by making the voltage LOW 

delay(1000);  // wait for a second 

} 
 
 

All'interno della funzione di loop, il primo comando accende il LED impostando il 

relativo pin su HIGH, poi interviene 'ritardo' di 1000 millisecondi (1 secondo), in cui 
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la scheda semplicemente attende, poi il LED viene spento, impostando il pin a 

LOW e viene richiamata una ulteriore attesa di 1 secondo. Se vuoi far lampeggiare 

il LED più velocemente, come puoi immaginare, la chiave sta nel cambiare il 

parametro di ritardo, tra le parentesi tonde () della funzione di delay. 
 
 

 

 
 

Questo tempo di ritardo è espresso in millisecondi, quindi se desideri che il led 

lampeggi due volte più velocemente, ti basterà modificare il valore da 1000 a 500. 

Questo imposterà una pausa di mezzo secondo, invece che di un secondo. Caricando 

il nuovo codice e dovresti vedere il LED lampeggiare più rapidamente. 
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Lezione 3 LED 
 
 

Introduzione 

In questa lezione imparerai a cambiare la luminosità di un led usando differenti 

valori di resistenza. 

 

Componenti Richiesti: 

(1) x Elegoo UNO R3 

(1) x LED rosso da 5mm 

(1) x Resistenza da 220 ohm 

(1) x Resistenza da 1k ohm 

(1) x Resistenza da 10k 

(2) x M-M connettori (Connettori maschio-maschio) 
 
 
 

Introduzione ai componenti 

BREADBOARD MB-102： 

La breadboard ti permette di costruire dei prototipi di circuiti velocemente, senza 

necessità di saldare le connessioni, sotto un esempio. 
 
 

 



41 / 167  

Esistono breadboard di diverse dimensioni e configurazioni. Il tipo più semplice è 

costituito da una griglia di buchi in un blocco ci plastica. All’interno sono presenti 

strisce di metallo che mettono in connessione differenti fori su tutte righe 

corte(quelle verdine nell’immagine). Inserendo i piedini di diversi componenti nella 

stessa riga, si avrà un collegamento elettrico diretto tra di essi. 

Un canale più profondo è visibile al centro della breadboard, indica che li non sono 

presenti connessioni, perciò si potrà inserire un chip con i piedini metà nella parte 

superiore e metà in quella inferiore della breadboard senza che facciano 

cortocircuito (quindi senza che si colleghi un piedino con l’altro). 

Alcune breadboard hanno due strisce di buchi che si sviluppano lungo i bordi e che 

sono separate dalla griglia centrale. Esse hanno strisce di collegamento per tutta la 

lunghezza e sono solitamente usate per i per i voltaggi comuni. Essi sono 

comunemente usati per +5 volt e per la messa a terra (GND). Queste strisce sono 

dei binari che ti permettono di dare energia a più componenti o punti della 

breadboard. 

Le breadboard sono molto comode per la prototipazione, ma hanno alcune 

limitazioni, per esempio le connessioni sono temporanee e non sono affidabili come 

le connessioni saldate, se ti capita di avere problemi di intermittenza con i circuiti 

potrebbe essere per colpa delle connessioni sulla breadboard. 

 

LED: 

I LED sono ottimi indicatori luminosi, essi utilizzano una quantità molto esigua di 

elettricità ed hanno una vita quasi infinita. 

In questa lezione utilizzerai uno dei led più comuni tra quelli esistenti. Il led da 5mm. 

5mm si riferisce al diametro del LED. Altre dimensioni comuni sono la 33mm e la 

10mm. 

Non puoi collegare direttamente il LED alla batteria o all’erogatore ti voltaggio, in 

quanto: 

1) Il LED ha un lato positivo ed uno negativo, e non si accenderà se piazzato nel 

senso sbagliato. 

2) Il LED va utilizzato con una resistenza per limitare la quantità di corrente che 

fluisce attraverso di esso, altrimenti si brucia! 



42 / 167  

 

 

 
 

Se non utilizzi una resistenza con il led potrebbe distruggersi immediatamente 

avendo troppa corrente che fluisce in esso, la corrente surriscalderà e distruggerà 

la giunzione interna che produce la luce. 

Ci sono due modi per sapere qual è il lato positivo e quello negativo nel led. 

In primo luogo il piedino più lungo è quello positivo. 

In alternativa, dove il piedino negativo entra nel corpo del led c’è un piano metallico 

di dimensioni maggiori rispetto al positivo. 

Se ti capita di avere un led con il lato interno piano più grande in corrispondenza del 

piedino più lungo devi assumere che il piedino più lungo corrisponde al positivo. 

 
RESISTENZE: 

Come suggerisce il nome, le resistenze oppongono resistenza al flusso di elettricità. 

Più p alto il valore della resistenza, più resiste, e meno corrente elettrica fluirà 

attraverso di esso. 

Noi utilizzeremo i resistori per controllare quanta elettricità fluisce attraverso il led 

e di conseguenza controllare quanta luce produrrà il LED. 
 

 

Ma prima diciamo qualcosa di più sulle resistenze… 

L’unità di resistenza è chiamata Ohm, che solitamente è abbreviata con la lettera 

greca Ω Omega. Dato che un Ohm è un valore di resistenza molto masso (non 

oppone quasi nessuna resistenza), si accompagna spesso il valore di resistenza con 

kΩ (1,000 Ω) e MΩ (1,000,000 Ω). I due valori si leggono come kilo-ohm e mega- 

ohm. 

In questa lezione utilizzeremo tre diversi tipi di resistenza tutte con valori diversi: 

220Ω, 1kΩ and 10kΩ. Queste resistenze sembrano tutte uguali, eccetto per le strisce 

colorate su di esse. Queste strisce indicano il valore della resistenza. 
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Il codice dei colori delle resistenze ha tre strisce colorate ed una ora ad una 

estremità. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A differenza dei LED, le resistenze non hanno un capo negativo ed uno positivo, e 

possono essere collegati indifferentemente in un verso o nell’altro. 

Se trovi questo tipo di approccio troppo complicato, puoi semplicemente leggere il 

flag sui nostri pacchi di resistenze per determinarne il valore di resistenza! 

Oppure puoi usare un multimetro digitare. 
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Connessione 

Schema 
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Diagramma di Collegamento 
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La scheda UNO è un ottimo generatore di 5 volt, che noi utilizzeremo per dare 

energia a led e resistenze. Non necessiti di fare niente oltre al collegare la tua scheda 

UNO con il cavo usb. 

Con collegata la resistenza da 220 Ω, il LED ti apparirà molto luminoso. Se cambi la 

resistenza e invece della 220 Ω utilizzi una resistenza da 1k Ω il led apparirà 

leggermente meno luminoso. Infine collegando la resistenza da 10k Ω, il led sarà 

molto poco luminoso, quasi spento. 

Utilizza il collegamento con del cavo rosso, togliendolo dalla breadboard e 

rimettendolo al suo posto, funzionerà da bottone di accensione, e dovresti riuscire 

a notare la differenza tra acceso e spento. 

Al momento hai una tensione di 5V sul primo piedino della resistenza, il secondo 

piedino della resistenza è collegato ad un capo del led e poi all’altro capo del LED è 

collegato con la messa a terra GND. Se spostiamo la resistenza da prima a dopo il 

LED come indicato nell’immagine di sotto, il LED continuerà a rimanere acceso. 

Vorrai probabilmente rimettere la resistenza al suo posto, non importa in quale lato 

del LED viene posizionata la resistenza, l’importante è che sia posizionata da qualche 

parte! 

Foto d’esempio 
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Lezione 4 LED RGB 

Introduzione: 

I LED RGB sono un modo divertente di aggiungere un po’ di colore ai tuoi progetti… 

Dato che sono come 3 led regolari in uno, il loro utilizzo e la loro connessione non è 

molto differente rispetto a quelli già visti. 

Ne esistono 2 versioni, la prima, con Anodo in comune e la seconda con Catodo in 

comune. 

La versione con l’Anodo in comune utilizza i 5V sul pin comune mentre la seconda 

lo vuole connesso alla messa a terra GND. 

Come per ogni led necessitiamo di connettere qualche resistenza in linea (3 totali) 

in modo da limitare la corrente che lo attraversa. 

Nel nostro codice accenderemo il led nello stato di colore rosso, poi si dissolverà nel 

colore verde, in seguito si dissolverà nel colore Blu che tornerà rosso. 

Facendo così cicleremo su tutti i colori che possono essere ottenuti. 

Componenti Richiesti: 

(1) x Elegoo UNO R3

(1) x Breadboard con 830 punti di aggancio

(4) x Connettori M-M (Connettori Maschio-Maschio)

(1) x LED RGB

(3) x Resistenza da 220 ohm
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Introduzione ai componenti 

LED RGB: 

A prima vista i LED RGB (Red, Green, Blue) sembrano dei normali led. Tuttavia 

all’interno del solito corpo del led ci sono3 ledi differenti, uno Rosso, uno Verde e 

ovviamente uno Blu. Controllando la luminosità di ogni led individualmente puoi 

controllare e mischiare praticamente qualsiasi colore tu voglia. 

I colori si mischiano nello stesso modo in cui si mischiano i colori in una tavolozza – 

aggiustando la luminosità in ognuno dei tre LED. La parte più difficile di tutto questo 

è utilizzare differenti valori di resistenza (o resistenze variabili) come abbiamo fatto 

nella lezione 2, ma questo comporta un sacco di lavoro! 

Fortunatamente per noi la scheda UNO ha una funzione analogWrite che puoi 

utilizzare sui pin marcati con il simbolo ~, la quale permette di fornire una quantità 

variabile di potenza per ogni singola uscita, e quindi per ogni singolo LED. 

Il LED RGB ha quattro piedini. Tre di essi sono l’ingresso positivo dei tre led presenti 

nel corpo, un capo per ogni led, il quarto è un l’ingresso negativo in comune per tutti 

e 3 i led. 
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Qui in fotografia puoi vedere 4 Elettrodi LED. Un pin separato per ognuno dei colori, 

verde, blu o rosso, esso è chiamato Anodo. Dovrai sempre collegare il “+” ad esso.  

Il catodo va collegato al “-“ (GND, messa a terra), se colleghi i piedini in un modo 

differente il led non si accenderà. 

L’ingresso negativo in comune per i tre led è il secondo pin dal lato con il piatto. 

Esso è anche il piedino più lungo dei 4 e verrà connesso alla messa a terra. 

Ogni led interno al corpo necessita una resistenza da 220Ω per prevenire che troppa 

corrente fluisca attraverso di esso. I tre capi dei LED (uno rosso, uno verde, ed uno 

blu) vanno connessi ai pin di output della scheda UNO utilizzando le resistenze da 

220Ω. 
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COLORI: 

Il poter creare ogni tipo di colore mischiando e variando la quantità di Rosso, Verde 

e Blu è dovuto al fatto che i tuoi occhi hanno tre tipi di ricettori per la luce in essi 

(verde, rosso e blue). I tuoi occhi e il tuo cervello processano la quantità di rosso, 

verde e blu, e la convertono in uno spettro di colori. 

In questo modo utilizzando 3 led molto vicini, stiamo semplicemente imbrogliando 

gli occhi, facendogli credere che sia un colore solo invece che tre. La stessa idea è 

utilizzata in TV dove gli schermi LCD hanno puntini rossi, verdi e blu molto vicini uno 

all’altro formando ogni trio forma un pixel. 

Se impostiamo la stessa luminosità per tutti e tre i led, il colore finale che si 

svilupperà sarà il bianco. Se spegniamo il led Blue, quindi tenendo acceso solo rosso 

e verde alla stessa luminosità, la luce apparirà gialla. 

Possiamo controllare la luminosità di ognuno dei tre colori Rosso, verde e blu 

separatamente, mischiandoli e creando qualsiasi colore vogliamo. 

Il nero non è considerato un colore, ma semplicemente l’assenza di luce. Infatti, 

l’unico modo pe avvicinarci a quel colore e semplicemente spegnendo tutti e tre i 

colori. 
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Teoria (PWM) 

Pulse Width Modulation (PWM) è una tecnica per controllare la potenza. 

Si usa anche qui per controllare la luminosità di ogni singolo LED. 

Il diagramma qui sotto mostra il segnale da uno dei pin PWM della scheda UNO. 

Approssimativamente ogni 1/500 di secondo l’uscita PWM produce una pulsazione. 

La lunghezza di tale pulsazione è controllata dalla funzione analogWrite. Perciò 

analogWrite(0) non produrrà alcuna pulsazione, mentre analogWrite(255) produrrà 

una pulsazione che durerà fino all’inizio della prossima pulsazione, perciò l’uscita 

sarà allo stato di ON per tutto il periodo. 

Se specifichiamo un valore nella funziona analogWrite che è compresa tra 0 e 255, 

verrà prodotto a una pulsazione. Se l’uscita è alta, per esempio, solo per il 5% del 

tempo, qualsiasi cosa ci sarà connessa a tale uscita riceverà il 5% della potenza 

disponibile. 

Se l’output è a 5V per il 90% del tempo, il carico riceverà il 90% della potenza emessa. 

Non possiamo vedere il LED accendersi e spegnersi a tale velocità, perciò, al nostro 

occhio sembrerà semplicemente un cambio di luminosità. 
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Connessioni 

Schema 
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Diagramma di collegamento 
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See Lesson 2 for details about program uploading if there are any errors. 

Il codice inizia specificando quali pin verranno usati per quali colori: 

// Define Pins 

#define BLUE 3 

#define GREEN 5 

#define RED 6 Il prossimo passo è quello di scrivere la funzione di setup. Come 

abbiamo imparato nelle lezioni precedenti, la funzione di setup viene eseguita una 

sola volta dopo che viene resettata la scheda di Arduino. In questo caso, tutto 

quello che fa la funzione è definire che i tre pin che andremo ad utilizzare saranno 

degli output. 

void setup() 

{ 

pinMode(RED, OUTPUT); 

pinMode(GREEN, OUTPUT); 

pinMode(BLUE, OUTPUT); 

digitalWrite(RED, HIGH); 

digitalWrite(GREEN, LOW); 

digitalWrite(BLUE, LOW); 

} 

Prima di guardare la funzione di “loop”, andiamo a vedere l’ultima funzione nel 

codice. 

Code 
After wiring, please open the Sketch in folder path: Tutorial > English > code > 

Lesson 4 RGB LED > RGB_LED, and click UPLOAD to upload the program. 
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Prova  tu  stesso  ad  aggiungere  diversi  colori  al tuo  codice  e  caricalo  sulla  scheda 
Arduino per vedere l’effetto del LED. 

Foto d’esempio 

La definizione delle variabili. 

redValue = 255; // choose a value between 1 and 255 to change the color. 

greenValue = 0; 

blueValue = 0; 

Questa funzione ha tre argomenti, uno per la luminosità del rosso, uno per il verde 

e uno per il led blu. In ogni caso i tre numeri dovranno avere un range compreso tra 

0 e 255, dove 0 significa spento e 255 significa massima luminosità. La funzione si 

occuperà di chiamare “analogWrite” per impostare la luminosità di ogni led. 

Se guardi la funzione “loop” puoi vedere che viene settata la quantità di rosso verde 

e blu che vogliamo visualizzare, dopodiché viene fatta una pausa di un secondo 

prima di iniziare con il prossimo colore. 

#define delayTime 10 // fading time between colors 

delay(delayTime); 
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Lezione 5 Input Digitali 
 
 

Introduzione 
In questa lezione imparerai ad utilizzare il bottone a pressione con un input digitale 

per accedere e spegnere un LED. 

Premendo un primo bottone si accenderà il LED, mentre premendo il secondo 

bottone il led verrà spento. 

 
Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Breadboard con 830 punti di aggancio 

(1) x LED rosso da 5mm 

(1) x Resistenza da 220 ohm 

(2) x Interruttore a pressione (bottone) 

(7) x Connettori M-M (Connettori Maschio-Maschio) 
 
 

Introduzione ai componenti 
INTERRUTTORI A PRESSIONE: 

Gli interruttori sono componenti molto semplici. Quando premi un bottone 

vengono connessi due contatti, in modo che l’elettricità possa fluire attraverso di 

essi. 

Il piccolo interruttore tattile che viene utilizzato in questa lezione ha quattro 

connessioni, ciò spesso mette in confusione. 
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In realtà ci sono solamente due connessioni elettriche. All’interno dell’interruttore 

i pin B e C sono connessi insieme come lo sono anche A e D. 

 
Connessioni 
Schema 

 

 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 

 
 

Diagramma di Collegamento 
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Nonostante il corpo dell’interruttore sia quadrato, i pin sporgono da due lati opposti 

dell’interruttore. Questo significa che i pin permettono l’inserimento 

dell’interruttore solamente in un verso sulla breadboard, questo è l’unico verso 

corretto per evitare cortocircuiti. 

Ricordati che il LED deve avere il piedino più corto (negativo) collegato a sinistra. 
 
 

Codice 
Dopo aver effettuato tutti i collegamenti apri il programma che trovi nella cartella 

“code” chiamato “Lesson 5 Digital Inputs” e premi Upload per caricare il programma. 

Se visualizzi qualche errore, torna alla lezione 2 per i dettagli su come caricare 

programmi sulla schedina Arduino. 

 

Dopo aver caricato il codice sulla tua scheda UNO. Premendo il bottone di sinistra 

vedrai accendersi il led, premendo invece quello di destra il led verrà spento. 

La prima parte del codice definisce tre variabili, una per ogni singolo dei te pin che 

verranno usati. Il “ledPin” è il pin di output, “buttonApin” è il primo dei due bottoni 

per accendere e spegnere il led, mentre “buttonBpin” è il secondo bottone dei due. 

La funzione setup definisce ledPin come un OUTPUT normale, ma ora andiamo a 

vedere come comportarci con gli altri due input. In questo caso il pinMode dei due 

interruttori verrà settato così come vedi di seguito ad “INPUT_PULLUP”: 

pinMode(buttonApin, INPUT_PULLUP); 

pinMode(buttonBpin, INPUT_PULLUP); 

Impostare la modalità di input come INPUT_PULLUP significa che il pin verrà 

utilizzato come input, ma che se nient’altro è connesso al pin di output esso dovrà 

essere “pulled up” quindi in modalità HIGH. In altre parole, il valore di default 

dell’input sarà HIGH a meno che venga portato a LOW della pressione del bottone 

che ha l’altra coppia di piedini è connesso all’uscita GND. 

Quando un bottone viene premuto, connette il pin di input al pin GND perciò il 

primo non sarà più in modalità HIGH. 

Dato che l’input è normalmente in HIGH, e viene portato a LOW solamente quando 

viene premuto il bottone, il senso del bottone è impostato al contrario. Ci 

occuperemo di questo in seguito, nella funzione “loop”. 
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void loop() 

{ 

if (digitalRead(buttonApin) == LOW) 

{ 

digitalWrite(ledPin, HIGH); 

} 

if (digitalRead(buttonBpin) == LOW) 

{ 

digitalWrite(ledPin, LOW); 

} 

} 

Nella funzione di “loop” ci sono due istruzioni “if”. Una per ogni bottone. 

Ognuna di esse esegue una lettura “digitalRead” sull’opportuno input. 

Ricorda che quando un bottone viene premuto il corrispondente input verrà 

impostato a LOW, se il bottone A è portato a LOW allora la funzione  “digitalWrite” 

su ledPin verrà impostato ad HIGH, accendendo il led. 
Ugualmente,  quando  il  bottone  B viene premuto,  viene  impostato  ledPin  a  LOW 

spegnendo il led. 

Foto d’esempio 



 

Lezione 6 Cicalino Attivo (Active Buzzer) 
 
 

Introduzione 
In questa lezione, imparerai come generare del suono con un cicalino attivo. 

 

Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Cicalino Attivo (Active buzzer) 

(2) x Connettori F-M (Connettori di DuPont Femmina-Maschio) 
 

Introduzione ai componenti 
BUZZER: 

Il cicalino elettronico è alimentato a corrente continua ed equipaggiato con un 

circuito integrato. 

Essi sono largamente usati nei computer, stampanti, fotocopiatrici, allarmi, giochi 

elettronici, dispositivi elettronici per autoveicoli, telefoni, cronometri ed altri 

prodotti di elettronica per dispositivi vocali. 

I cicalini vengono divisi in due categorie, attivi e passivi. Girando i due cicalini con i 

piedini verso l’alto, quello con il circuito verde è il cicalino passivo, al contrario 

quello chiuso con la superficie nera liscia è quello attivo. 

La  differenza  tra  i  due  è  che  il  cicalino  attivo  ha  un  ingresso  oscillante,  perciò 
genererà suono quando elettrificato. Un cicalino passivo al contrario, non ha tale 

ingresso, perciò non farà nessun suon quando riceverà della corrente continua come 

segnale. Con il cicalino passivo dovrai utilizzare un segnale ad onde quadre la cui 

frequenza dovrà essere compresa tra i 2K e i 5K. 

Il  cicalino  attivo  è  spesso  più  costoso  di  uno  passivo,  ciò  è  dovuto  al  fatto  che 

all’interno di esso sono presenti alcuni circuiti oscillanti. 
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Connessione 
Schema 
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Diagramma di Collegamento 
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Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 6 Making Sounds”, clicca su UPLOAD per caricare il programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

 

Foto d’esempio 



 

Lezione 7 Cicalino Passivo (Passive Buzzer) 
 
 

Introduzione 
In questa lezione imparerai ad utilizzare un cicalino passivo. 

L’obiettivo di questo esperimento è di generare otto suoni differenti, ognuno con 

una durata di 0.5 secondi: Do (523Hz), Re (587Hz), Mi (659Hz), Fa (698Hz), Sol 

(784Hz), La (880Hz), Si (988Hz) Do Acuto (1047Hz). 

 
Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Cicalino Passivo (Passive buzzer) 

(2) x Connettori F-M (Connettori di DuPont Femmina-Maschio) 
 

Introduzione ai Componenti 
Cicalino Passivo: 

Il principio di funzionamento del cicalino passivo si fonda sull’utilizzo della 

modulazione PWM le cui onde permettono la vibrazione dell’arie e la generazione 

del suono. 

Impostando la frequenza delle onde correttamente, si possono generare suoni 

differenti. Per esempio inviando una pulsazione di 523Hz si genera un Do, con una 

pulsazione di 587Hz si genera un re, con una pulsazione di 659Hz si genera un Mi. 

Mettendo insieme tutto ciò si può costruire e suonare una canzone. 

Devi solo prestare attenzione a non utilizzare la funzione analogWrite() della scheda 

UNO per generare le pulsazioni per il cicalino, in quanto le pulsazioni generate da 

analogWrite sono fisse a 500Hz 
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66 / 167 

Connessioni 
Schema 
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Diagramma di Collegamento 
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Collega il Cicalino alla scheda UNO, il cavo rosso (positivo) al pin 8 e il cavo nero 

(negativo) alla messa a terra GND 

 
Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 7 Passive Buzzer”, clicca su UPLOAD per caricare il programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

Prima di eseguire questo codice, controlla di aver installato la libreria <pitches> 

oppure reinstallala se necessario. Altrimenti il codice non riuscirà a funzionare. 

Per i dettagli su come caricare i file delle librerie, guarda la lezione 1. 
 
 
 

Foto d’esempio 
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Lezione 8 Interruttore ad Inclinazione 
 
 

Introduzione 
In questa lezione, imparerai come utilizzare un interruttore ad inclinazione in modo 

da percepire inclinazione di piccoli angoli. 

 
Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Interruttore ad inclinazione (Tilt Ball switch) 

(2) x Connettori F-M (Connettori di DuPont Femmina-Maschio) 
 
 

Introduzione ai Componenti 
Interruttore ad inclinazione: 

L’interruttore ad inclinazione (tilt ball switch) ti permette di percepire orientamento 

o inclinazione del sensore. Questi sensori sono piccoli, poco costosi, consumano 

poca corrente e sono semplici da utilizzare. Se usati correttamente questi sensori 

non si consumano. La loro semplicità li ha resi popolari per giochi, gadget e vari 

strumenti. Spesso sono chiamati "mercury switches"(interruttori al mercurio), "tilt 

switches" (interruttori di inclinazione o "rolling ball sensors" (sensori di rotolamento 

a sfera) per ovvie ragioni. 

Questi sensori sono spesso costituiti da qualche tipo di cavità (quella cilindrica è la 

più comune, ma non l’unica) con una massa mobile conduttiva all’interno, come una 

bolla di mercurio o una pallina libera di rotolare. Uno dei due estremi della cavità ha 

due elementi che conducono elettricità (poli). Quando il sensore cambia angolo e 

viene posto sottosopra, la massa rotola contro i poli formando un cortocircuito, è 

un comportamento analogo al premere un bottone. 

Nonostante non siano precisi o flessibili come dei completi accelerometri, i sensori 

di inclinazione sono sensibili al movimento e all’orientamento. 

Questo tipo di sensori hanno la qualità di poter essere utilizzati da soli senza extra 

circuiti extra che ne analizzino i segnali. 

Gli accelerometri, al contrario, hanno output digitali o analogici che vanno analizzati 

con circuiti extra 
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Diagramma di collegamento 
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Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 8 Ball Switch”, clicca su UPLOAD per caricare il programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

 
 

Foto d’esempio 



 

Lezione 9 Servo 
 
 

Introduzione 
Il Servo è un tipo di motore che può ruotare solamente di 180 gradi. Viene 

controllato inviando impulsi elettrici tramite la scheda UNO. Queste pulsazioni 

indicano al servo in quale posizione deve ruotare. 

Il Servo ha tre cavi: il cavo marrone è la messa a terra e va connessa alla porta GND 

della scheda UNO., il rosso è il cavo di alimentazione e va connesso alla porta dei 5v, 

infine il cavo arancio è il cavo del segnale e va connesso al pin numero 9. 

 
Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Servo (SG90) 

(3) x Connettori M-M (Connettori Maschio-Maschio) 
 

Introduzione ai componenti 
Servo SG90 

 Universale per connettori JR e FP 

 Lunghezza cavo: 25cm 

 Nessun carico; velocità operativa: 0.12 sec / 60 gradi (4.8V), 0.10 sec / 60 gradi 

(6.0V) 

 Coppia di stallo (4.8V): 1.6kg/cm 

 Temperatura: -30~60'C 

 Larghezza di banda morta: 5us 

 Voltaggio di lavoro: 3.5~6V 

 Dimensioni: 1.26 in x 1.18 in x 0.47 in (3.2 cm x 3 cm x 1.2 cm) 
 peso: 4.73 oz (134 g) 
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Diagramma di collegamento 
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Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 9 Servo”, clicca su UPLOAD per caricare il programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

Prima di eseguire questo codice, controlla di aver installato la libreria <Servo> 

oppure reinstallala se necessario. Altrimenti il codice non riuscirà a funzionare. 

Per i dettagli su come caricare i file delle librerie, guarda la lezione 1. 
 
 

Foto d’esempio 
Nella foto, il cavo marrone del servo è collegato tramite il cavo nero M-M, il cavo 

 

 

rosso del servo è collegato tramite il cavo rosso M-M, il cavo arancio del servo è 
collegato tramite il cavo giallo M-M. 
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Lezione 10 Modulo Sensore ad Ultrasuoni 
 
 

Introduzione 
Il sensore ad ultrasuoni è grande per tutti i tipi di progetti che necessitano di 

misurare le distanze, progetti che necessitano di evitare gli ostacoli per esempio. 

Il sensore HC-SR04 è economico e facile da utilizzare dato che utilizza una libreria 

specifica, scritta per questi sensori. 

 
Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Modulo sensore ad Ultrasuoni 

(4) x Connettori F-M (Connettori di DuPont Femmina-Maschio) 
 

Introduzione ai componenti 
Sensore Ultrasonico 

Il modulo sensore ultrasonico HC-SR04 permette un range di misura 2cm-400cm 

senza contatto, l’accuratezza del sensore può raggiungere i 3mm. Il modulo include 

un trasmettitore ad ultrasuoni, un ricevitore e un circuito di controllo. 

Questo è il principio base di funzionamento: 

(1) utilizzando il pin Trigger si invia un segnale HIGH per almeno 10us 

(2) il modulo invierà automaticamente otto onde a 40kHz ed individuerà l’eventuale 

ritorno una pulsazione di segnale. 

(3) il sensore risponderà sul pin Echo con un impulso HIGH della durata 

corrispondente a quelle del viaggio delle onde sonore. 

Distanza Test = (tempo di livello alto x velocità del suono (340m/s) /2 ) 

Il diagramma del tempo è visualizzato qui sotto. Devi semplicemente inviare una 

veloce pulsazione 10us all’input del trigger per iniziare la misura, dopodiché il 

modulo invierà 8 veloci cicli di ultrasuoni a 40kHz per intercettare l’eco. Tramite 

queste pulsazioni è possibile calcolare la distanza tra il sensore e l’oggetto 

incontrato. Il range viene calcolato inviando un segnale di trigger e ricevendo il 

segnale su Echo. La formula per il calcolo è questa: us/58 =centimetri oppure us/148 

=pollici; oppure ancora, il range = tempo di HIGH * velocità (340m/s) /2; 

Ti suggeriamo di usare cicli di misure non inferiori ai 60ms per prevenire 

l’accavallamento di più misurazioni. 
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Codice
Utilizzare la libreria scritta per questo sensore ci permetterà di avere un codice 

molto semplice e corto. 

Il codice include la libreria all’inizio del nostro codice, in seguito vengono usati 

semplici comandi che permettono di utilizzare il sensore. 

Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 10 Ultrasonic Sensor Module”, clicca su UPLOAD per caricare il 

programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

Prima di eseguire questo codice, controlla di aver installato la libreria < HC-SR04> 

oppure reinstallala se necessario. Altrimenti il codice non riuscirà a funzionare. 
Per i dettagli su come caricare i file delle librerie, guarda la lezione 1. 

Foto d’esempio 
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Apri il monitor seriale e vedrai i dati come quelli d’esempio qui sotto: 

Clicca sul tasto del monitor seriale per attivarlo. Le basi riguardo al monitor seriale 

sono state introdotte nella lezione 1, se hai qualche dubbio torna a tale lezione. 
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Lezione 11 Sensore di Temperatura e umidità DHT11

Introduzione
In this tutorial we will learn how to use a DHT11 Temperature and Humidity Sensor. 

It’s accurate enough for most projects that need to keep track of humidity and 

temperature readings. 

Again we will be using a Library specifically designed for these sensors that will 

make our code short and easy to write. 

Componenti Richiesti:
(1) x Elegoo UNO R3

(1) x Modulo rilevatore di Temperatura ed umidità DHT11

(3) x Connettori F-M (Connettori di DuPont Femmina-Maschio)

Introduzione ai Componenti
Sensore di temperatura ed umidità

Il sensore di temperatura ed umidità DHT11 è un sensore composto che permette 

di avere in output segnali digitali calibrati di temperatura ed umidità 

Questo modulo digitale contiene una tecnologia che permette di assicurare 

eccellente affidabilità e stabilità per un lungo periodo. 
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Il sensore include un sensore resistivo di umidità e un dispositivo NTC di misura della 

temperatura, entrambi connessi con un microcontrollore ad alte performance ad 8- 

bit 

Applicazioni: HVAC, deumidificatori, test e ispezione di equipaggiamenti, beni di 

consumo, automotive, controlli automatici, data logger, stazioni meteo, applicazioni 

casalinghe, regolatori di umidità, medico e altre misure e controllo di umidità. 

 
Parametri del prodotto: 

Relativi all’umidità: 

Risoluzione:  16Bit  

Ripetibilità: ±1% RH 

Accuratezza: At 25℃  ±5% RH 

Intercambiabilità: pienamente intercambiabile 

Tempo di risposta: 1 / e (63%) of 25℃ 6s 

1m / s air 6s 

Isteresi: <± 0.3% RH 

Stabilità a lungo termine: <± 0.5% RH / anno 

Temperatura: 

Risoluzione: 16Bit 

Ripetibilità: ±0.2℃ 

Range: a 25℃ ±2℃ 

Tempo di risposta: 1 / e (63%) 10S 
Caratteristiche Elettriche 

Voltaggio richiesto: DC 3.5～5.5V 

Corrente richiesta: misurata 0.3mA standby 60μA 

Periodo di campionatura: maggiore di 2 secondi 

Descrizione dei Pin: 

1, Voltaggio VDD (+) 3.5～5.5V DC 

2 DATA dati seriali, bus singolo 

3, NC, pin vuoto 

4, GND messa a terra (-) 
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Connessioni 
Schema 



 

 
 

Diagramma dei collegamenti 
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Come puoi vedere per il sensore sono necessarie solo 3 connessioni, in quanto un 

pin non viene utilizzato. 

Le connessioni sono Voltaggio, messa a terra e segnale. L’ultimo può essere 

connesso ad un qualsiasi pin sulla nostra scheda UNO 

 
Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 12 DHT11 Temperature and Humidity Sensor”, clicca su 

UPLOAD per caricare il programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

Prima di eseguire questo codice, controlla di aver installato la libreria < SimpleDHT > 

oppure reinstallala se necessario. Altrimenti il codice non riuscirà a funzionare. 

Per i dettagli su come caricare i file delle librerie, guarda la lezione 1. 
 

 

Foto d’esempio 



 

Carica il programma e poi apri il monitor seriale, potrei vedere i dati come qui sotto: 

(viene visualizzata la temperatura dell’ambiente, nel nostro esempio sono 22 gradi) 

Clicca sul tasto del monitor seriale per attivarlo. Le basi riguardo al monitor seriale 

sono state introdotte nella lezione 1, se hai qualche dubbio torna a tale lezione. 
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Lezione 12 Modulo Joystick Analogico 
 
 

Introduzione 
I joystick analogici sono un ottimo modo per aggiungere controlli al tuo progetto. 

In questo tutorial imparerai ad utilizzare il modulo del Joystick analogico. 

 
Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Modulo Joystick 

(5) x Connettori F-M (Connettori di DuPont Femmina-Maschio) 
 

Introduzione ai Componenti 
Joystick 

Il modulo ha 5 pin: VCC, Ground, X, Y, Key. Nota che le scritte sul modulo potrebbero 

essere leggermente differenti in base a dove hai comprato il modulo. 

Il joypad per il pollice è analogico e può fornire letture più accurate di un semplice 

joystick direzionale il quale solitamente utilizza qualche tipo di bottone o 

interruttore meccanico. Inoltre, puoi premere il joystick come se fosse un semplice 

bottone, il quale invierà un segnale di pressione. 

In questo esempio utilizzeremo due pin analogici per leggere i dati di X e Y, un terzo 

pin analogico verrà utilizzato per leggere le pressioni del joystick, o altrimenti può 

essere lasciato sconnesso. Per ricevere letture stabili dal pin KEY/Select, è 

necessario connettere la tensione VCC tramite una resistenza di pull-up. Il resistore 

interno della scheda Arduino presente nei pin digitali può essere utilizzato a questo 

scopo. 
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Necessitiamo 5 connessioni al joystick. 

Le connessioni sono: Key, Y, X, Voltaggio e messa a terra. 

Y e X sono analogici mentre Key è digitale. Se non ti serve utilizzare la pressione del 

joystick puoi semplicemente non utilizzarlo ed utilizzare solamente gli altri 4 pin. 

 
Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 13 Analog Joystick Module”, clicca su UPLOAD per caricare il 

programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

 
I joystick analogici sono dei semplici potenziometri, perciò restituiscono dei valori 

analogici. 

Quando un joystick è nella posizione centrale dovrebbe fornire un valore intorno al 
512. Il range di valori varia tra 0 e 1024 

Foto d’esempio 



92 / 167  

Apri il monitor seriale per vedere dei dati simili ai seguenti: 

Clicca sul tasto del monitor seriale per attivarlo. Le basi riguardo al monitor seriale 

sono state introdotte nella lezione 1, se hai qualche dubbio torna a tale lezione. 
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Lezione 13 Modulo di Ricezione IR 
 
 

Introduzione 
Utilizzare un modulo ad infrarossi (IR) è un ottimo modo per controllare da remoto 

i tuoi progetti. I moduli ad infrarossi sono molto semplici da utilizzare. I questo 

tutorial connetteremo il ricevitore IR alla nostra scheda UNO, poi utilizzeremo una 

libreria scritta appositamente per questo sensore. 

Nel nostro file di codice sono presenti tutti i codici esadecimali che sono disponibili 

nel telecomando ad infrarossi. Il codice sarà anche in grado di riconosce se un tasto 

riceve una pressione prolungata. 

 
Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Ricevitore IR 

(1) x Telecomando IR 

(3) x F-M cavi (Cavi di DuPont Femmina-Maschio) 
 

Introduzione ai componenti 
Sensore ricevitore di infrarossi: 

I rilevatori di infrarossi sono piccoli microchips con una fotocellula sensibile alla luce 

infrarossa. Questi sensori sono quasi sempre utilizzati per il controllo remoto – tutte 

le TV e lettori DVD hanno uno di questi sensori sulla parte frontale per ricevere i 

comandi inviati dal telecomando. All’interno dei telecomandi è presente il led ad 

infrarossi che emette pulsazioni alla giusta frequenza di luce che comanda al 

televisore di accendersi, spegnersi o cambiare canale. La luce ad infrarossi non è 

visibile agi occhi umani. Questo significa che il sensore necessita di un po’ di test 

prima di essere impostato correttamente. 

Ci sono alcune differenze tra questi sensori ed i fotoresistori (CdS): 

I rilevatori ad infrarossi hanno speciali filtri per la luce ad infrarossi, essi non sono 

ottimi per rilevare la luce visibile. D’altro canto, i fotoresistori sono ottimi per 

rilevare la luce gialla/verde ma non lo sono per la luce ad infrarossi. 

I rilevatori ad infrarossi hanno al loro interno un demodulatore che rileva la luce ad 

infrarossi a 38kHZ. Un semplice led ad infrarossi non viene rilevato, necessita una 

modulazione PWM a 38kHz. 
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I fotoresistori al contrario non hanno nessun tipo di demodulatore e possono 

rilevare qualsiasi tipo di frequenza (compresa al corrente continua), limitati solo 

della velocità di risposta del fotoresistore (che è circa 1kHz) 

I rilevatori ad infrarossi hanno un uscita digitale – se rilevano un segnale infrarossi a 

38kHz portano l’uscita a LOW (0V) oppure non rilevano nessun segnale e portano 

l’uscita a HIGH (5V). I fotoresistori invece hanno un comportamento simile alle 

resistenze, cambiano il valore di resistenza in base alla quantità di luce alla quale 

sono esposti. 

Cosa puoi misurare 
 

 

Come puoi nel grafico dei dati qui sopra, il picco di sensibilità si trova a 38 kHz ed il 

picco di illuminazione del led è a 940 nm. Si possono usare frequenze tra i 35 kHz ed 

i 41 kHz ma avremo una notevole riduzione di sensibilità e quindi una riduzione di 

sensibilità rispetto al caso precedente. 

Allo stesso modo si possono utilizzare LED con una frequenza d’onda compresa tra 

850 nm e 1100 nm ma non funzioneranno bene come quelli con frequenze d’onda 

comprese tra 900 nm e 1000 nm, perciò fai attenzione a scegliere i led che si 

accoppino a dovere. Controlla il datasheet (scheda dati) dei tuoi led quando per 

verificare la lunghezza d’onda. Cerca di acquistarli a 940 nm e ricorda che 940 nm è 

una luce non visibile all’occhio umano. 
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Il ricevitore ad infrarossi è dotato di 3 connessioni. 

Le connessioni sono: Segnale, Voltaggio, Messa a terra. 

Il “-“ è la messa a terra, “S” è il segnale, e il pin in mezzo è il voltaggio 5V. 
 

Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 14 IR Receiver Module”, clicca su UPLOAD per caricare il 

programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

Prima di eseguire questo codice, controlla di aver installato la libreria < IRremote > 

oppure reinstallala se necessario. Altrimenti il codice non riuscirà a funzionare. 

Per i dettagli su come caricare i file delle librerie, guarda la lezione 1. 
 

Per prima cosa spostiamo <RobotIRremote> all’esterno della cartella della libreria, 

va effettuato questo passaggio perché quella libreria è in conflitto con quella che 

utilizzeremo noi. Puoi semplicemente rispostare la cartella rimossa all’interno della 

libreria nel momento in cui avrai terminato di programmare il microcontrollore. 

Una volta che avrai installato la libreria devi semplicemente procedere e riavviare il 
tuo IDE. 

Foto d’esempio 
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Apri il monitor seriale e potrai vedere i dati qui sotto. 

Clicca sul tasto del monitor seriale per attivarlo. Le basi riguardo al monitor seriale 

sono state introdotte nella lezione 1, se hai qualche dubbio torna a tale lezione. 
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Lezione 14 Display LCD 
 
 

Introduzione 
In questa lezione, imparerai come collegare ed utilizzare un display alfanumerico 

LCD. Questo display ha una retroilluminazione LED e può visualizzare due righe da 

16 caratteri ognuna. Sul display puoi vedere un rettangolino per ogni carattere del 

display ed i pixel che formano ogni carattere. Il display è solo bianco e blu ed è 

pensato per visualizzare solo del testo. 

In questa lezione eseguiremo il codice d’esempio per la libreria del display LCD, ma 

nella prossima lezione utilizzeremo il display per mostrare la temperatura rilevata 

da un sensore. 

 
Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Modulo LCD1602 

(1) x Potenziometro (10k) 

(1) x Breadboard con 830 fori 

(16) x Connettori M-M (connettori Maschio-Maschio) 
 

Introduzione ai componenti: 
LCD1602 

Specifiche dei pin del modulo LCD1602: 

VSS: Il pin da connettere alla messa a terra 

VDD: Il pin che verrà connesso alla sorgente di voltaggio +5 V 

VO: Il pin atto ad aggiustare il contrasto del display LCD1602 

RS: Il pin di selezione del registro, che ti permette di controllare su quale area della 

memoria del display LCD si andrà a scrivere il nuovo carattere. Puoi selezionare il pin 

del registro dei dati, che mantiene ciò che andremo a scrivere sullo schermo, oppure 

il registro delle istruzioni, il quale riceve le istruzioni su cosa fare di seguito. 

R/W: Questo pin serve a selezionale la modalità di lettura o scrittura. 

E: il pin di abilitazione, quando alimentato con bassi livelli di energia, determina 

l’esecuzione di istruzioni rilevanti sul modulo LCD. 

D0-D7：Pin che leggono e scrivono i dati. 

A and K: Pin che controllano la retroilluminazione. 
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Schema 
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Diagramma di collegamento 
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Il display LCD necessita di sei pin di Arduino, tutti i pin devono essere output digitali. 

Il display necessita anche di essere connesso ai 5V e alla messa a terra GND. 

Ci sono numerose connessioni da effettuare, allineare il display alla parte alta della 

breadboard può risultarti utili ad identificare i pin senza fare troppa confusione, 

specialmente se la breadboard ha le righe numerate. Non dimenticare di collegare 

il cavo giallo (in figura) che connette il potenziometro al pin 3 del display. Il 

potenziometro viene utilizzato per controllare il contrasto del display. Potresti 

scoprire che il display viene alimentato senza il pin di testa collegato ad esso. Se è 

cosi, segui le istruzioni nella prossima sezione. 

 
Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 22 LCD Display”, clicca su UPLOAD per caricare il programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

Prima di eseguire questo codice, controlla di aver installato la libreria < LiquidCrystal > 

oppure reinstallala se necessario. Altrimenti il codice non riuscirà a funzionare. 

Per i dettagli su come caricare i file delle librerie, guarda la lezione 1. 
 

Dopo aver caricato il codice sulla scheda Arduino dovresti vedere il messaggio 'hello, 

world' apparire sul display, seguito da un numero crescente a partire da zero. 

La prima cosa che trovi nel codice è la linea: 

#include <LiquidCrystal.h> 

Questa linea specifica ad Arduino di utilizzare la libreria Liquid Crystal. 

Di seguito trovi una linea da modificare. Essa definisce quali pin di Arduino sono i 

corrispettivi connessi al display. 

LiquidCrystal lcd(7, 8, 9, 10, 11, 12); 

Dopo aver caricato questo codice assicurati che la retroilluminazione sia accesa e 

regola il potenziometro in modo da vedere il messaggio di testo predisposto. 

Nella funzione “setup” ci sono due comandi: 

lcd.begin(16, 2); 

lcd.print("Hello, World!"); 

Il primo definisce nella libreria Liquid Crystal quante colonne e righe ha il display con 

il quale andremo ad interfacciarci. La seconda linea visualizza il messaggio che 

vedremo sullo schermo. 
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Nella funzione di “loop” abbiamo altri due comandi: 

lcd.setCursor(0, 1); 

lcd.print(millis()/1000); 

Il primo imposta la posizione del cursore, perciò dove il prossimo testo apparirà (nel 

nostro caso colonna 0 e riga 1). Colonne e righe iniziano la numerazione da 0 e non 

da 1. La seconda linea visualizza il numero di millisecondi passati da quando la 

scheda Arduino è stata resettata. 

Foto d’esempio 
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Lezione 15 Termometro 
 
 

Introduzione 
In questa lezione, utilizzerai un display LCD per visualizzare la temperatura. 

 

Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Modulo LCD1602 

(1) x Resistenza 10k ohm 

(1) x Termistore 

(1) x Potenziometro 

(1) x Breadboard con 830 punti di collegamento 

(18) x Connettori M-M (Connettori Maschio – Maschio) 
 
 

Introduzione ai componenti 

Termistore 
Un Termistore è una resistenza termica – una resistenza che cambia la sua resistenza 

in base alla sua temperatura. Tecnicamente tutte le resistenze sono termistori, infatti 

la lori resistenza cambia leggermente con la temperatura, ma questo cambiamento è 

solitamente molto lieve e difficile da misurare. I termistori sono costruiti in modo che 

il loro livello di resistenza cambi drasticamente con il variare della temperatura, 

questa variazione può essere anche 100 ohm per grado! 

Ci sono due tipi di termistori, NTC (negative temperature coefficient) e PTC (positive 

temperature coefficient). In generale vedrai per misurare la temperatura sensori NTC. 

I termistori PTC sono spesso utilizzati come fusibili resettabili, un aumento di 

temperatura incrementa la resistenza, questi significa che più corrente passa 

attraverso di essi più essi si scaldano e bloccano la corrente, questo è molto utile per 

proteggere i circuiti. 
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Connessione 
Schema 
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Diagramma di collegamento 
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Il layout montato sulla breadboard è basato sul layout visto nella lezione 22, in modo 

da semplificare l’apprendimento di ciò che si ha sulla breadboard. 

Ci sono alcuni cavetti di collegamento vicino al potenziometro che sono stati 

leggermente spostati in questo layout. 

La resistenza da 10 kΩ ed il termistore sono entrambi delle aggiunte rispetto alla 

lezione già vista. 

 

Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 23 Thermometer”, clicca su UPLOAD per caricare il programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

Prima di eseguire questo codice, controlla di aver installato la libreria < LiquidCrystal > 

oppure reinstallala se necessario. Altrimenti il codice non riuscirà a funzionare. 

Per i dettagli su come caricare i file delle librerie, guarda la lezione 1. 
 

Il codice di questo esercizio è basato sul codice della lezione 22. Caricalo su Arduino 

e dovresti vedere la temperatura sul display cambiare semplicemente stringendo 

tra le tue dita il termistore. 

Abbiamo pensato potesse essere utile inserire una linea di commento sopra al 

comando dell’LCD. 

// BS    E    D4 D5    D6  D7 

LiquidCrystal lcd(7, 8, 9, 10, 11, 12); 

Questo ti rende più facile la situazione nel caso tu decidessi di cambiare i pin 

utilizzati. 

Nella funzione “loop” accadono due cose interessanti. Primo è necessario convertire 

l’ingresso analogico della lettura di temperatura del sensore nella temperatura 

attuale. In seguito dobbiamo poi eseguire delle operazioni per visualizzare il dato 

ottenuto. 

Per prima cosa, guarda come viene calcolata la temperatura. 

int tempReading = analogRead(tempPin); 

double tempK = log(10000.0 * ((1024.0 / tempReading - 1))); 

tempK = 1 / (0.001129148 + (0.000234125 + (0.0000000876741 * tempK * tempK )) 

* tempK ); 

float tempC = tempK - 273.15; 
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attuale. 

Per  riempire  gli  spazi  vuoti,  imposta  il  cursore  sulla  posizione  in  cui  dovrebbe 

comparire la lettura e quindi stampa il valore. 

Foto d’esempio 

float tempF = (tempC * 9.0)/ 5.0 + 32.0; 

Visualizzare il cambio di temperature sul display LCD può risultare leggermente 

complicato. Il problema maggiore nella scrittura può essere che il nuovo numero 

non avrà lo stesso numero di cifre di quello precedente. Così per esempio, se la 

temperatura passa da 101.50 a 99.00 c’è il pericolo che un numero extra della 

vecchia lettura resti sul display. Per evitare questo, riscrivi l’intera linea del display 

LCD ogni ciclo di loop. 

lcd.setCursor(0, 0); 

lcd.print("Temp C "); 

lcd.setCursor(6, 0); 

lcd.print(tempF); 

Il commento che ti sembrerà strano Serve per ricordarti delle 16 colonne del display. 

Tu puoi stampare una stringa di tale lunghezza con soli spazi dove andrà la  lettura 
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Lezione 16 Otto LED con 74HC595 
 
 

 
Introduzione 

 

In queste lezione imparerai come utilizzare otto led con la tua scheda UNO senza 

necessità di utilizzare 8 pin di output! 

Sebbene tu possa collegare più di 8 led ognuno con una resistenza alla scheda UNO, 

presto finirai i pin di output disponibili. Se non hai necessità di collegare molti 

componenti alla scheda non sarà un problema, ma spesso necessitiamo bottoni, 

sensori, servo, etc. e prima ancora di accorgerti avari finito i pin disponibili. Cosi, 

invece di far succedere questo, andremo ad utilizzare un chip convertitore da seriale 

a parallelo chiamato 74HC595. Questo chip ha 8 output (perfetto) e tre input 

utilizzati per comunicare dati al chip un poco alla volta. 

Questo chip rende leggermente più lento il processo che comanda i LED (puoi 

comandare i led circa 500.000 volte al secondo invece di 8.000.000 al secondo) ma 

resta comunque molto veloce, e soprattutto più veloce di quanto un occhio umano 

possa vedere, ne vale quindi la pena! 

 
Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x breadboard con 830 punti di collegamento 

(8) x LED 

(8) x Resistenze da 220 ohm 

(1) x Chip 74hc595 

(14) x M-M cavetti (Cavetti di collegamento Maschio – Maschio) 
 
 

Introduzione al componente 
74HC595 Registro a scorrimento: 

Il registro a scorrimento è un tipo di chip che mantiene ciò che gli viene comandato 

per ognuna delle sue 8 zone di memoria, ognuna di essa può registrare i valori 1  o 

0. Per impostare questi valori on oppure off, inseriremo i dati utilizzando i pin ‘Data’ 

e ‘Clock’ sul chip. 
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Il pin del clock necessita di ricevere otto pulsazioni. Ogni pulsazione se il pin del dato 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

è HIGH, un 1 viene inserito nel registro a scorrimento, altrimenti viene inserito uno 
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0. Quando tutti e 8 i valori sono ricevuti, abilitando il pin ‘Latch’ il chip tutti questi 

valori vengono copiati sul registro di Latch. Questo è necessario altrimenti, mentre 

viene impostato il valore per i led nel registro a scorrimento vedremmo tremolare 

la luce dei led. 

Questo chip ha inoltre un pin di abilitazione output (OE), esso è utilizzato per 

abilitare o disabilitare tutti gli output in una volta sola. Puoi collegare questo ad un 

pin PWM della scheda UNO ed utilizzare ‘analogWrite’ per controllare la luminosità 

dei led. Questo pin è attivo a LOW, perciò possiamo collegarlo al pin GND. 

 
Connessione 
Schema 
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Visto che abbiamo otto led ed otto resistenze da utilizzare, ci sono un bel po’ di 

connessioni da fare. 

È probabilmente più facile collegare prima il chip 74HC595 dato che quasi tutte le 

connessioni passeranno attraverso di esso. Collegatelo con il piccolo intaglio a forma 

di U sulla parte superiore rivolta verso la parte alta della breadboard. Il pin 1 del chip 

è quello alla sinistra dell’intaglio. 

Il Pin digitare 12 dalla scheda UNO va collegato al pin #14 del chip a scorrimento di 

registro. 

Il Pin digitare 11 dalla scheda UNO va collegato al pin #12 del chip a scorrimento di 

registro. 

Il Pin digitare 19 dalla scheda UNO va collegato al pin #11 del chip a scorrimento di 

registro. 

Tutti gli output tranne uno del chip sono posizionato sul lato sinistro del circuito. 

Quindi per semplificare le connessioni, metteremo i led da quel lato. 

Dopo aver posizionato il chip, metti in posizione anche i resistori. Devi prestare 

attenzione che nessun capo dei resistori ne tocchi con un altro. Ti suggeriamo di 

controllare questa cosa ancora prima di alimentare la scheda UNO. Se trovi difficoltà 

nell’aggiustare la posizione di resistori, puoi aiutarti tagliando una parte del loro filo 

metallico, accorciandolo, e facendo in modo che il resistore stia più vicino alla 

superficie delle breadboard. 

Ora posizioni i led sulla breadboard. Il piedino più lungo del led è quello positivo ed 

esso va collegato in direzione del chip, indipendentemente dalla posizione della 

breadboard alla quale sono collegati. 

Collega i cavetti di collegamento come mostrato qui sotto. Non dimenticarti quello 

che collega il pin 8 del circuito integrato alla colonna della messa a terra GND della 

breadboard. Carica il codice indicato qui sotto e prova i led! Ogni led dovrebbe 

illuminarsi a turno prima che tutti siano accesi, dopodiché si spegneranno tutti ed il 

ciclo si ripeterà. 

 
Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 24 Eight LED with 74HC595”, clicca su UPLOAD per caricare il 

programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 
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La prima cosa da fare è definire i 3 pin che andremo ad utilizzare. Essi sono i pin di 

output digitale della scheda UNO che saranno connessi a Latch, clock e Data del 

circuito integrato 74HC595. 

int latchPin = 11; 

int clockPin = 9; 

int dataPin = 12; 

Ora, la variabile ‘leds’ è definita. Questa verrà utilizzate per mantenere il pattern di 

quali led sono attualmente accesi o sopenti. Il tipo di dato ‘byte’ rappresenta numeri 

utilizzando otto bit. Ogni bit può essere on oppure off (0 o 1), ciò è perfetto per 

tenere traccia degli otto led per conoscerne il loro stato. 

byte leds = 0; 

La funzione 'setup' semplicemente setta i tre pin digitali che useremo come output. 

void setup() 

{ 

pinMode(latchPin, OUTPUT); 

pinMode(dataPin, OUTPUT); 

pinMode(clockPin, OUTPUT); 

} 

La funzione ‘loop’ inizialmente spegne tutti i led, dando alla variabile ‘leds’ il valore 

0. Dopo di che chiama la funzione 'updateShiftRegister', che invierà il pattern al 

registro a scorrimento, così tutti i led verranno spenti. Ci occuperemo del 

funzionamento della funzione 'updateShiftRegister' più avanti. 

La funzione di loop attende per mezzo secondo, dopodiché inizia a contare da 0 a 7, 

utilizzando il ciclo ‘for’ e la variabile ‘i’. Ogni volta, utilizza la funzione ‘bitSet’ per 

settare il bit he controlla il led nella variabile ‘leds’. Chiama anche la funzione 

'updateShiftRegister' in modo da aggiornare i led e farli corrispondere al valore della 

variabile ‘leds’. 

C’è mezzo secondo di intervallo tra l’aggiornamento del valore della ‘i’ e 

l’illuminazione del LED. 

void loop() 

{ 

leds = 0; 

updateShiftRegister(); 

delay(500); 

for (int i = 0; i < 8; i++) 
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{ 

bitSet(leds, i); 

updateShiftRegister(); 

delay(500); 

} 

} 

La funzione 'updateShiftRegister', per prima cosa imposta il valore di ‘latchPin’ a 

LOW, in seguito chiama la funzione 'shiftOut' prima di impostare nuovamente 

‘latchPin’ ad HIGH. La funzione prende quattro parametri. Due si essi sono i pin 

utilizzati per Data e Clock. Il terzo parametro specifica da quale lato del registro si 

vuole iniziare. Noi inizieremo da destra con il bit meno significativo 'Least Significant 

Bit' (LSB). L’ultimo parametro è il dato che verrà inserito nel registro, nel nostro caso 

sarà ‘leds’. 

void updateShiftRegister() 

{ 

digitalWrite(latchPin, LOW); 

shiftOut(dataPin, clockPin, LSBFIRST, leds); 

digitalWrite(latchPin, HIGH); 

} 

Nel caso tu voglia accendere un LED piuttosto che spegnerlo, puoi utilizzare una 

funzione di Arduino (bitClear) sulla variabile ‘leds0. Questa imposterà il bit scelto 

della variabile ‘leds’ a 0 e dovrai semplicemente chiamare la funzione 

'updateShiftRegister' per aggiornare i LED. 
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Foto d’esempio 
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Lezione 17 Il Monitor Seriale 
 
 

Introduzione 
In questa lezione, utilizzeremo il progetto costruito nella lezione 16 aggiungendo la 

possibilità di controllare i LED dal computer utilizzando il controllo seriale di Arduino. 

Il monitor seriale è il ‘collegamento’ tra il tuo PC e la tua scheda UNO. Esso ti 

permette di inviare e ricevere messaggi di testo, utilizzato spesso per debug della 

piattaforma e controllo della scheda UNO tramite la tastiera! 

Per esempio, sarai in grado di inviare comandi dal tuo pc ed accedere i LED. 

In questa lezione utilizzerai esattamente le stesse parti ed un layout della 

breadboard simile alla lezione 16, perciò se non lo hai già fatto, torna ora alla lezione 

16. 

 

Passaggi 
Dopo aver caricato il codice sulla tua scheda UNO clicca in alto a destra, sul bottone 

presente sulla barra degli strumenti dell’IDE di Arduino. Il bottone è lo stesso che 

vedi cerchiato qui sotto. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
67 
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La seguente finestra si aprirà. 

Clicca sul bottone del monitor seriale per attivare il monitor seriale. Le vasi del 

monitor seriale sono state introdotte in dettaglio nella lezione numero 1. 
 

 

 
 

Questa finestra è chiamata Serial Monitor ed è parte del software IDE di Arduino. Il 

suo lavoro è permettere di inviare messaggi dal tuo computer alla scheda UNO 

(tramite USB) ma anche di ricevere messaggi da essa. 

Il messaggio “Enter LED Number 0 to 7or 'x' to clear” viene inviato da Arduino e ci 

spiega quale comando possiamo inviare ad esso: possiamo mandare ‘x’ (per 

spegnere tutti i LED) oppure il numero del led che vogliamo accendere (dove 0 è il 

LED più in basso, 1 è il successivo verso l’alto, fino al 7 che è l’ultimo più in alto). 

Prova a digitare i seguenti comando nell’area superiori del monitor seriale, quella 

allo stesso livello del bottone “send”. Premi “send” dopo aver digitato ogni carattere: 

x 0 3 5 

Digitare x non avrà alcun effetto in quanto tutti i led sono già spenti, ma quando 

digiterai ogni numero il corrispondente led si accenderà e riceverai il messaggio  di 
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conferma dalla scheda UNO. Il monitor seriale apparirà come mostrato qui sotto. 
 

 

 
 

Digita nuovamente x e premi “send!” per spengere tutti i LED. 

 
Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 25 The Serial Monitor”, clicca su UPLOAD per caricare il 

programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

Come potresti esserti aspettato, il codice è basato sul codice della lezione 24. Così, 

ora ti spiegheremo solo una parte di esso. Troverai utile far riferimento al codice 

completo presente sul tuo IDE Arduino. 

Alla fine della funzione di ‘setup’ ci sono tre nuove linee. 

void setup() 

{ 

pinMode(latchPin, OUTPUT); 

pinMode(dataPin, OUTPUT); 
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pinMode(clockPin, OUTPUT); 

updateShiftRegister(); 

Serial.begin(9600); 

while (! Serial); // Wait until Serial is ready - Leonardo 

Serial.println("Enter LED Number 0 to 7 or 'x' to clear"); 

} 

Per prima cosa, abbiamo il comando 'Serial.begin(9600)'. Questo apre la 

comunicazione sul monitor seriale, in modo che la scheda UNO possa inviare 

comandi tramite la connessione USB. Il valore 9600 è chiamato ‘baud rate’ della 

connessione. Esso indica la velocità con cui i dati sono inviati. Puoi modificare questo 

valore ed alzarlo, ma dovrai cambiarlo anche sul serial monitor di Arduino inserendo 

lo stesso valore. Parleremo di questo più avanti, ma per ora lasciamolo a 9600. 

La linea inizia con un ciclo di ‘while’ per assicurarsi che ci sia qualcuno dall’altro capo 

del cavo USB con cui comunicare prima di iniziare ad inviare messaggi. 

Altrimenti, il messaggio potrebbe essere inviato ma non visualizzato. Questa linea è 

necessaria solamente se stai utilizzando un Arduino Leonardo perché la scheda 

Arduino UNO Si resetta in automatico quando apri il monitor seriale, al contrario 

questo non succede con la scheda Leonardo. 

L’ultima delle nuove linee in ‘setup’ invia il messaggio che vedremo in cima al 

monitor seriale. 

La funzione ‘loop’ è dove avvengono tutte le azioni. 

void loop() 

{ 

if (Serial.available()) 

{ 

char ch = Serial.read(); 

if (ch >= '0' && ch <= '7') 

{ 

int led = ch - '0'; 

bitSet(leds, led); 

updateShiftRegister(); 

Serial.print("Turned on LED "); 

Serial.println(led); 

} 

if (ch == 'x') 
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{ 

leds = 0; 

updateShiftRegister(); 

Serial.println("Cleared"); 

} 

} 

} 

Tutto ciò che avviene all’interno del loop è contenuto all’interno della condizione if. 

Così, se la chiamata della funzione 'Serial.available()' non ritorna il valore ‘true’, 

nulla accade. 

Serial.available() ritorna ‘true’ se dei dati sono stati inviati alla scheda UNO ed essa 

è pronta a processare. I messaggi in ingresso sono mantenuti in quello che è 

chiamato buffer e 'Serial.available()' ritorna ‘true’ se il buffer non è vuoto. 

Se un messaggio è stato ricevuto, allora sarà nella successiva linea di codice: 

char ch = Serial.read(); 

Questa funzione legge il prossimo carattere presente nel buffer e lo rimuove da esso. 

Assegna alla variabile ‘ch’ il valore letto. La variabile ‘ch’ è di tipo ‘char’ che è 

l’abbreviazione di ‘character’ e come suggerisce il nome, permette di salvare un 

singolo carattere. 

Se hai seguito le istruzioni nel prompt in cima al monitor seriale, questo carattere 

sarà una singola digitazione, e sarà o un numero compreso tra 0 e 7 inclusi oppure 

la lettera ‘x’. 

La dichiarazione ‘if’ nella linea seguente controlla se è il carattere digitato è una 

singola digitazione controllando che ‘ch’ sia maggiore o uguale al carattere ‘0’ e 

minore o uguale al carattere ‘7’. Può sembrarti strano comparare dei caratteri in 

questa maniera, ma è perfettamente accettabile. 

Ogni carattere è rappresentato da un unico numero, chiamato valore ASCII. Questo 

significa che comparando dei caratteri usando >= e <= si comparano i rispettivi valori 

ASCII. 

Se il test è passato, allora si prosegue alla prossima linea di codice: 

int led = ch – '0'; 

Ora stiamo eseguendo dei calcoli aritmetici con dei caratteri. Stiamo sottraendo il 

carattere ‘0’ da qualsiasi valore sia stato digitato. In questo modo se è stato digitato 

‘0’ allora ‘0’ – ‘0’ equivale a 0. Se è stato digitato ‘7’ allora ‘7’ – ‘0’ equivale a 7 perché 

attualmente è il valore ASCII utilizzato nella sottrazione. 
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Dato che conosciamo il numero del LED che vogliamo accendere necessitiamo 

solamente di aggiornare il corretto bit nella variabile ‘leds’ ed aggiornare il registro 

a scorrimento. 

bitSet(leds, led); 

updateShiftRegister(); 

Le seguenti due linee visualizzano un messaggio di conferma sul monitor seriale. 

Serial.print("Turned on LED "); 

Serial.println(led); 

La prima linea utilizza Serial.print invece di Serial.println. La differenza tra le due è 

che Serial.print non va a capo dopo aver stampato il messaggio passatogli come 

parametro. Usiamo questo nella prima linea, perché stiamo stampando il messaggio 

in due parte, prima il messaggio generico 'Turned on LED ' e di seguito il numero del 

LED scelto. 

Il numero del led è salvato in una variabile ‘int’ invece di essere in una stringa di 

testo. Serial.print è in grado di ricevere come parametri sia stringe di testo incluse 

tra doppi apici, sia variabili ‘int’ o per questo motivo quasi ogni tipo di variabile. 

Dopo che lo la condizione ‘if’ è stata controllata, quando ogni singola digitazione è 

stata manipolata, c’è un secondo ‘if’ che si occupa di controllare se il carattere ‘ch’ 

equivale alla lettera ‘x’. 

if (ch == 'x') 

{ 

leds = 0; 

updateShiftRegister(); 

Serial.println("Cleared"); 

} 

Se così è, Allora pone a 0 tutti i valori dei led, aggiorna il registro a scorrimento e 

invia un messaggio di conferma. 
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Lezione 18 Fotocellula 
 
 

Introduzione 
In questa lezione imparerai come misurare l’intensità della luce utilizzando un input 

analogico. Nella lezione costruirai un circuito in grado di usare il livello della luce per 

controllare la quantità di LED che si accenderanno. La fotocellula sarà situata nella 

parte inferiore della breadboard ad ha un funzionamento simile ad un 

potenziometro. 

 
Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Breadboard con 830 punti di collegamento 

(8) x LED 

(8) x Resistenze da 220 ohm 

(1) x Resistenze da 1k ohm 

(1) x Circuito integrato 74hc595 

(1) x Fotoresistore (Fotocellula) 

(16) x M-M Cavetti (Cavetti di collegamento Maschio - Maschio) 
 

Introduzione al componente 
Fotocellula: 

La fotocellula utilizzata è un tipo di resistore dipendente dalla luce, spesso 

abbreviato con LDR. Come suggerisce il nome questi componenti agiscono 

similmente a dei resistori, fatta eccezione per il fatto che la resistenza cambia in 

base alla quantità di luce che la illumina. 

La fotocellula che utilizzeremo ha una resistenza di circa 50 kΩ al buio e circa 500 Ω 

quando sottoposta ad alta luminosità. Per convertire questo valore di resistenza 

variabile in qualcosa che possiamo misurare con un input analogico nella nostra 

scheda UNO R3 misureremo il voltaggio. 

Il modo più semplice di fare questa cosa è combinare il fotoresitore con un resistore 

fisso. 
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Il resistore e la fotocellula insieme agiscono come un potenziometro. Quando la luce 

è intensa la resistenza del fotoresistore è molto bassa se comparata con il valore 

della resistenza fissa, in questo caso è come se il potenziometro fosse girato verso 

il massimo. 

Quando la fotocellula è sottoposta ad una luce molto bassa o nulla, la resistenza 

sarà molto più alta rispetto alla seconda resistenza fissa da 1 kΩ, così sarà come se 

il potenziometro sia girato verso la messa a terra GND. 

Carica il codice che ti abbiamo fornito e prova a coprire la fotocellula con il dito, 

dopodiché avvicinala ad una sorgente di luce. 



125 / 167  

Connessione 
Schema 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
126 / 

 
 

Diagramma di collegamento 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
167 



127 / 167  

Code 

 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 26 Photocell”, clicca su UPLOAD per caricare il programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

La prima cosa da notare è che abbiamo cambiato il nome del pin analogico 

chiamandolo ‘lightPin’ al posto di ‘potPin’ dato che non avremo un potenziometro 

collegato. L’unico cambiamento sostanziale al codice è la linea che calcola quanti 

led vengono accesi. 

int numLEDSLit = reading / 57;    // all LEDs lit at 1k 

Questa volta, dividiamo il valore grezzo letto per 57 invece che per 114. In altre 

parole lo dividiamo per la metà rispetto a quanto abbiamo fatto con il 

potenziometro, vogliamo infatti dividere per nove zone il range di valori, il primo 

corrisponderà a tutti i led spenti e l’ultimo corrisponderà a tutti i led illuminati. 

Questo fattore è dovuto alla resistenza fissa da 1 kΩ. Questo perché quando la 

fotocellula ha una resistenza pari a 1 kΩ (la stessa del resistore fisso), la lettura 

grezza sarà 1023 / 2 = 511. Questo significa che tutti i led vengono accesi e quindi 

numLEDSlit sarà pari a 8. 
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Foto d’esempio 
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Lezione 19 Display a segmenti e 74HC595 
 
 

Introduzione 
Dopo aver imparato le lezioni 24, 25 e 26; utilizzeremo il Circuito integrato 74HC595 

(registro a scorrimento) per controllare un display a segmenti. Tale display a 

segmenti ha la possibilità di visualizzare i numeri da 9 a 0. 

 

Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Breadboard con 830 punti di collegamento 

(1) x Circuito integrato 74HC595 

(1) x Display ad 1 Cifra e 7-Segmenti 

(8) x Resistenza 220 ohm 

(26) x M-M cavetti (Cavetti di collegamento Maschio – Maschio) 
 

Introduzione ai componenti 
Display a sette segmenti: 

Sotto qui puoi vedere il diagramma del display a sette segmenti. 
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Le dieci cifre da 0 a 9 corrispondono all’accensione di ogni segmento come segue (la 

seguente tabella viene applicata a display a sette segmenti con catodo in comune, 

nel caso tu voglia usare l’anodo in comune, dovrai sostituire tutti gli 1 con degli 0. 
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Connessione 
Schema 
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Diagramma di collegamento 



 

La seguente tabella mostra la corrispondenza dei pin del display a sette segmenti con 

i pin del circuito integrato 74HC595. 

 
74HC595 pin 

 
Seven shows remarkable 

control pin (stroke) 

Q0 7 (A) 

Q1 6 (B) 

Q2 4 (C) 

Q3 2 (D) 

Q4 1 (E) 

Q5 9 (F) 

Q6 10 (G) 

Q7 5 (DP) 

Passaggio uno: connetti il circuito integrato 74HC595 

Per prima cosa connetti il positivo e la messa a terra: 

VCC (pin 16) e MR (pin 10) connesso ai 5V 

GND (pin 8) e OE (pin 13) alla messa a terra 

Connetti i pin DS, ST_CP e SH_CP: 

DS (pin 14) connesso al pin 2 della scheda UNO R3 (La linea gialla nella figura 

sottostante) 

ST_CP (pin 12, latch pin) connesso al pin 3 della scheda UNO (La linea blu nella figura 

sottostante) 

SH_CP (pin 11, clock pin) connesso al pin 5 della scheda UNO R3 (La linea bianca nella 

figura sottostante) 

Passaggio due: connetti il display a sette segmenti 

Connetti i pin 3 e 8 del display a sette segmenti con il GND della scheda UNO (questo 

esempio utilizza il catodo in comune, se utilizzi l’anodo in comune, connetti i pin 3 e 

8 del display a sette segmenti con il +5V della scheda UNO) 

 
In accordo con la tabella qui sopra connetti i pin del circuito integrato 74HC595 Q0 

~ Q7 con i corrispondenti pin (A ~ G e DP) del display a sette segmenti, e poi per 

ogni piedino aggiungi in serie una resistenza da 220 ohm 
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Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 27 74HC595 And Segment Display”, clicca su UPLOAD per 

caricare il programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

 
 
 

Foto d’esempio 



 

Lezione 20 Display a sette segmenti con quattro cifre 
 
 

Introduzione 
In questa lezione imparerai come utilizzare un display a 7 segmenti con quattro cifre. 

Quando si utilizza un display a 7 segmenti ed 1 cifra, nota che se utilizzi l’anodo in 

comune, esso viene collegato alla sorgente +5V, se invece si utilizza il catodo in 

comune, i pin del catodo in comune vanno connessi al pin GND. 

Quando si utilizza un display a 7 segmenti e 4 cifre, il pin dell’anodo o catodo in 

comune è utilizzato per controllare qualche cifra viene visualizzata, perciò si può 

utilizzare solamente una cifra alla volta, il principio della persistenza della visione ti 

permetti di visualizzare tutti i numeri visualizzati in quanto la velocità di ciclo è 

talmente veloce che il suo intervallo è molto difficile da notare. 

 
Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Breadboard con 830 punti di collegamento 

(1) x Circuito integrato 74HC595 

(1) x Display a 4 Cifre e 7-Segmenti 

(4) x Resistenza 220 ohm 

(23) x M-M cavetti (Cavetti di collegamento Maschio – Maschio) 
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Introduzione ai componenti 
Display a sette segmenti e quattro cifre 
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Connessione 
Schema 



 

Diagramma di collegamento 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

138 / 167 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

139 / 167 

Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il programma “Lesson 28 

Four Digital Seven Segment Display clicca su UPLOAD per caricare il programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore durante il 

caricamento torna a vedere la lezione 2 

Foto D’esempio 



 

Lezione 21 Motore DC 
 
 

Introduzione 
In questa lezione imparerai come controllare in piccolo motore DC utilizzando la tua scheda UNO R3 

ed un transistor. 

 
Componenti Richiesti: 
(1) x Elegoo UNO R3 

(1) x Breadboard con 830 punti di collegamento 

(1) x Circuito integrato L293D 

(1) x Pala della ventola e motore 3-6 V 

(5) x M-M cavetti (Cavetti di collegamento Maschio – Maschio) 

(1) x Modulo di alimentazione elettrica 

(1) x adattatore 9V1A 

Introduzione ai componenti 
Modulo di alimentazione elettrica 

Il  piccolo  motore  DC  utilizza  più  energia  di  quella  che  la  schedina  UNO  R3  può  sopperire 

direttamente. Se provassimo a collegare il motore direttamente con il pin della scheda UNO c’è una 

alta   possibilità   di   rovinare   la   scheda   UNO.   Per   questo   motivo 
alimentazione elettrica in modo da fornire la corretta alimentazione 

utilizzeremo un   modulo   di 
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Specifiche del prodotto 

 Interruttore di blocco On/Off 

 LED indicatore di accensione 

 Voltaggio in Input: 6.5-9v (DC) tramite plug 5.5mm x 2.1mm 

 Voltaggio in output: 3.3V/5v 

 Corrente massima in output: 700 mA 

 Linea di controllo output indipendente 0v, 3.3v, 5v con la breadboard 

 Piedini di uscita per un comodo uso esterno 

 Dimensioni: 2.1 in x 1.4 in 

 Connettore USB incorporato per alimentare un dispositivo esterno. 
 

Impostare il voltaggio di output 
 

 

Il voltaggio a sinistra e quello di destra possono essere configurati indipendentemente. Per 

selezionare il voltaggio di output, sposta il ponticello al pin corrispondente. Nota: il Led di accensione 

e le line collegate alla breadboard non vengono alimentate se entrambi i ponticelli sono in posizione 

di “OFF”. 
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Fa attenzione ad allineare il modulo correttamente sulla breadboard. Il pin negativo (-) sul modulo 

corrisponde alla linea blu (-) sulla breadboard ed il pin positivo (+) corrisponde alla linea rossa (+). 

Sbagliare questi collegamenti può portare ad una inversione di corrente sul tuo progetto. 

L293D

Questo è un chip molto utile. Può controllare due motori indipendentemente. Noi useremo 

solamente metà delle potenzialità di questo chip in questa lezione. La maggior parte dei pin sul lato 

di destra del chip sono a disposizione per il secondo motore. 

Nota importante:
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Specifiche del prodotto: 

• Componenti L293 e L293D Prodotti ora da Texas Instruments 

• Banda di Voltaggio in ingresso molto larga: 4.5 V - 36 V 

• Logica di input separata 

• Protezione ESD interna 

• Spegnimento Termico 

• input Immuni agli alti rumori 

• Funzionalità simi a SGS L293 e SGS L293D 

• Corrente in Output: 1 A per canale (600 mA per L293D) 

• Picchi di corrente in output: 2 A per canale (1.2 A per L293D) 

• Morsettiera per diodi in uscita, utilizzata per soppressione induttiva dei transistori. 
 
 
 
 
 
 
 
 
 
 
Informazioni di descrizione/Comandi 

L293 e L293D sono dispositivi a half-H quadrupli ad alta corrente. 

L293 è costruito per fornire una corrente guida bidirezionale con un voltaggio compreso tra 4.5V e 

36V e corrente superiore a 1A. L293D è costruito per fornire una corrente guida bidirezionale con 

un voltaggio compreso tra 4.5V e 36V e corrente superiori a 600mA. 

Entrambi i dispositivi sono strutturati per comandare carichi induttivi tipo solenoidi, relè, dc e motori 

passo-passo, così come altri carichi ad alta-corrente/alto-voltaggio in applicazioni con correnti di 

alimentazione positive. Tutti gli input sono compatibili con la logica dei circuiti integrati. Ogni uscita 

è un circuito di pilotaggio completo, con un transistore Darlington e una pseudo- fonte Darlington. 

Gli attuatori sono abilitati in coppia, si possono attivare gli attuatori 1 e due con il comando 1,2EN e 

gli attuatori 3 e 4 con il comando 3,4EN. Quando il comando di abilitazione è HIGH gli attuatori 

associati sono attivi, e la loro uscita è attiva, in fase con i loro input. Quando il comando di 

abilitazione è LOW, i rispettivi attuatori sono disabilitati, quindi il loro output è su off, in uno stato 

di alta impedenza. Con i giusti dati in ingresso, ogni paio di attuatori forma un full-H (detto anche 

ponte), un comando reversibile adatto a comandare solenoidi o per applicazioni con i motori. 
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Diagramma del blocco 
 
 
 
 

VCC1 

 

VCC2 

 

Essendo sono stufi di diagrammi di piedinatura indecifrabili all'interno schede, ti abbiamo disegnato 

uno schema adatto che pensiamo posa fornirti informazioni più pertinenti. 

Ci son o 3 cavi connessi con Arduino, due connessi al motore ed uno connesso alla batteria. 
 

 

Per utilizzare questi pin: 

Il lato sinistro si occupa per primo motore, il lato alla destra si occupa del secondo. E puoi utilizzare 

questo circuito con un solo motore connesso. 
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Connessione con Arduino 

M1 PWM – Connetti questo ad un pin PWM della scheda Arduino. Essi sono etichettati il pin 5 è un 

esempio. Utilizza in uscita un valore intero compreso tra 0 e 255, 0 indicherà spento, 128 mezza 

velocità e 255 massima velocità. 

M1 direction 0/1 e M1 direction 1/0 – Connetti questi due a due pin digitali su Arduino. Uno dei due 

pin dovrà essere impostato su HIGH e l’altro su LOW, in questo modo il motore girerà in una 

direzione. Invertendo le uscite a LOW la prima e HIGH la seconda il motore girerà nella direzione 

opposta. 
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Schema delle connessioni
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Schema di collegamento
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Il codice qui sotto non utilizza una sorgente di energia separata (esempio una 

batteria), al suo posto utilizza l’uscita 5V proveniente da Arduino. Nota. Questo 

potrebbe essere rischioso senza il controllo del circuito L293D. 

Non dovresti mai collegare un motore direttamente ad Arduino, perché quando 

spegni un motore si forma una retroazione elettrica. Con un piccolo motore questo 

potrebbe danneggiare l’Arduino, con un grande motore c’è il rischio che la scheda 

faccia scintille e si incendi. 

Code 
After wiring, please open the program in the code folder- Lesson 30 Relay and click 

UPLOAD to upload the program. See Lesson 2 for details about program uploading 

if there are any errors. 

After program loading, turn on all the power switches. The relay will pick up with a 

ringing sound. Then, the motor will rotate. After a period of time, the relay will be 

released, and the motor stops. 
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Foto d’esempio



Lezione 22 Relè

Introduzione
In questa lezione imparerai ad utilizzare un relè. 

Componenti Richiesti:
(1) x Elegoo UNO R3

(1) x Breadboard con 830 punti di collegamento

(1) x Pala della ventola e motore 3-6 V

(1) x Circuito Integrato L293D

(1) x 5v Relè

(1) x Modulo di alimentazione supplementare

(1) x Adattatore 9V 1A

(8) x M-M cavetti (Cavetti di collegamento Maschio – Maschio)
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Introduzione ai componenti
Relè:

Il relè è un interruttore attivato elettricamente. Molti relè utilizzano un 

elettromagnete che controlla un interruttore, ma altri utilizzano il principio del relè 

a stato solido. I relè son utilizzati quando è controllare un circuito con un segnale a 

bassa potenza (con un isolamento elettrico completo tra il circuito controllore ed il 

circuito controllato) oppure quando più circuiti devono essere controllati da un 

segnale singolo. Il primo relè venne usato come amplificatore nei circuiti del 

telegrafo a lunga distanza. Essi ripetevano il segnale ricevuto da un circuito e lo 

ritrasmettevano ad un altro. I relè vennero usati estensivamente negli scambi 

telefonici e nei primi computer per svolgere operazioni logiche. 

I relè che possono gestire l’alta potenza richiesta per controllare direttamente un 

motore elettrico o altri carichi vengono chiamati contattori. I relè a stato solido 

controllano circuiti senza parti mobili, utilizzando dispositivi con semiconduttori per 

attivare gli interruttori. Relè con caratteristiche operative calibrate e spesso 

multiple bobine vengono utilizzati per proteggere i circuiti da guasti e sovraccarichi. 

Nei sistemi elettrici moderni queste funzioni vengono eseguite da strumenti digitali 

chiamati “relè protettivi”. 

Sotto qui vedi uno schema su come comandare un relè con Arduino. 

Potresti fare confusione su come inserire il relè all’interno della breadboard. Come 

ti  mostra  l’immagine  qui  sotto,  devi  piegare  leggermente  uno  dei  pin  del  relè, 
dopodiché potrei inserirlo nella breadboard. 
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Schema di connessione
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Foto d’esempio

Code
After wiring, please open the program in the code folder- Lesson 30 Relay and click 

UPLOAD to upload the program. See Lesson 2 for details about program uploading 

if there are any errors. 

After program loading, turn on all the power switches. The relay will pick up with a 

ringing sound. Then, the motor will rotate. After a period of time, the relay will be 

released, and the motor stops. 



Lezione 23 Motore Passo-Passo

Introduzione
In questa lezione imparerai un metodo divertente e facile di comandare un motore 

passo-passo. 

Il motore che utilizzeremo ha già la sua scheda di movimento, ciò permette di 

connetterlo facilmente al UNO. 

Componenti Richiesti:
(1) x Elegoo UNO R3
(1) x Breadboard con 830 punti di collegamento
(1) x Modulo di guida del motore passo-passo ULN2003
(1) x Motore passo-passo
(1) x Adattatore 9V 1A
(1) x Modulo di alimentazione supplementare
(6) x F-M cavetti (Cavetti di collegamento di DuPont Femmina – Maschio)
(1) x M-M cavetti (Cavetti di collegamento Maschio – Maschio)

Introduzione ai componenti 
Motore passo passo
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Un motore passo-passo è un dispositivo elettromeccanico che converte impulsi 

elettronici in movimenti meccanici discreti. L’albero o il mandrino del motore passo- 

passo ruota di passi predefiniti che incrementano all’aumentare delle pulsazioni 

elettriche in grado di comandarlo che lo raggiungono nella giusta sequenza. La 

rotazione del motore ha diversi rapporti diretti con questi impulsi in ingresso 

applicati. La sequenza degli impulsi applicati è direttamente correlata alla direzione 

di rotazione dell’albero motore. La velocità di rotazione dell’albero motore è 

direttamente correlata alla frequenza degli impulsi di ingresso e la durata della 

rotazione è direttamente correlata al numero di impulsi di ingresso applicati. Uno 

dei vantaggi più significativi di un motore passo-passo è la sua capacità di essere 

controllato con precisione in un sistema a ciclo aperto. Il controllo in ciclo aperto 

significa che non è necessaria alcuna informazioni di feedback sulla posizione. 

Questo tipo di controllo elimina la necessità di costosi dispositivi di rilevamento e di 

feedback quali encoder ottici. La posizione è conosciuta semplicemente tenendo 

traccia degli impulsi in input. 

Parametri del motore passo-passo 28BYJ-48 

 Modello: 28BYJ-48

 Voltaggio: 5VDC

 Numero di fasi: 4

 Indice di variazione di velocità: 1/64

 Angolo di passo: 5.625° /64

 Frequenza: 100Hz

 Resistenza : 50Ω±7%(25℃)

 Frequenza in trazione quando inattivo: > 600Hz

 Frequenza non in trazione quando inattivo: > 1000Hz

 Torsione in trazione >34.3mN.m(120Hz)

 Torsione di posizionamento >34.3mN.m

 Torsione in Frizione: 600-1200 gf.cm

 Torsione in traino : 300 gf.cm

 Resistenza isolata >10MΩ(500V)
 Potenza elettrica isolata：600VAC/1mA/1s

 Grado di isolamento：A

 Aumento di temperatura <40K(120Hz)

 Rumore <35dB(120Hz,No load,10cm)
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Circuito di interfaccia 

Il motore passo-passo bipolare solitamente ha quattro cavi che escono da esso. 

Diversamente dai motori unipolari, i motori bipolari non hanno in centro una 

connessione comuni. Essi hanno insiemi di bobine indipendenti. Puoi distinguere 

questo tipo di motori da quelli unipolari misurando la resistenza tra i cavi. Dovresti 

trovare due paia di motori con resistenza uguale. Se hai due cavo del misuratore 

connessi con due cavi che non sono collegati (cioè, non collegati alla stessa bobina) 

dovresti vedere infinita resistenza (non continuità) 
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Scheda di guida ULN2003 

Descrizione del prodotto 
o Dimensioni: 42mmx30mm

o Chip utilizzato :ULN2003, 500mA

o LED A. B. C. D indicanti il funzionamento delle quattro fasi del motore.

o Il connettore bianco è il connettore standard per la quarta fase del motore paso- 

passo.

o Pin di alimentazione separati

o Lasciamo il resto dei pin del chip ULN2003 per tue future prototipazioni.

Il modo più semplice per interfacciarsi un motore passo-passo unipolare con

Arduino è utilizzare un transistor di breakout del chip ULN2003A. Il circuito

ULN2003A è in grado di controllare sette Darlington transistor, ciò come avere sette

transistor TIP120 tutti in una struttura. Il circuito ULN2003A può alimentare con più

di 500mA ogni singolo canale ed ha una caduta di tensione interna di circa 1V

quando acceso. Esso contiene anche dei diodi in grado di dissipare picchi di tensione
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quando comanda carichi induttivi. Per controllare il motore, applica il voltaggio ad 

ogni bobina in una specifica sequenza. La sequenza va similmente a questa: 

Qui sotto puoi vedere lo schema di come interfacciare un motore unipolare ai 

quattro pin di controllo utilizzati dal ULN2003A, ti mostra inoltre come interfacciarlo 

utilizzando quattro collegamenti. 
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Connessioni 
Schema 
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Diagramma di collegamento 
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Stiamo utilizzando 4 pin per controllare il motore. 

I Pin 8-11 Stanno controllando il Motore passo-passo. 

Abbiamo connesso la messa a terra dal UNO al motore passo-passo. 

Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 31 Stepper Motor”, clicca su UPLOAD per caricare il programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

Prima di eseguire questo codice, controlla di aver installato la libreria < Stepper > 

oppure reinstallala se necessario. Altrimenti il codice non riuscirà a funzionare. 

Per i dettagli su come caricare i file delle librerie, guarda la lezione 1. 

. 

Foto D’esempio 



Lezione 24 Controllare il motore passo-passo da remoto 

Introduzione 
In questa lezione imparerai un metodo veloce e semplice di controllare il motore 

passo-passo utilizzando il comando ad infrarossi. 

Il motore che useremo viene venduto con la propria scheda di controllo, che rende 

facile la connessione con il UNO. 

Dato che non vogliamo controllare il motore direttamente dalla UNO, utilizzeremo 

un piccolo e comodo alimentatore che si connetterà direttamente alla nostra 

breadboard per alimentarla con 9V e 1A. 

Il sensore ad infrarossi è connesso alla UNO direttamente dato che non necessita di 

una grande potenza. 

Componenti Richiesti: 
(1) x Elegoo UNO R3

(1) x Modulo ricevitore IR

(1) x comando IR

(1) x Modulo di comando motore passo-passo ULN2003

(1) x Motore passo-passo

(1) x Modulo di alimentazione supplementare

(1) x Adattatore 9V 1A

(9) x F-M cavetti (Cavetti di collegamento di DuPont Femmina – Maschio)

(1) x M-M cavetti (Cavetti di collegamento Maschio – Maschio)
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Connessione 
Schema 



Diagramma di collegamento 
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Stiamo utilizzando 4 pin per controllare il motore ed un pin per il sensore ad 

infrarossi. 

I pin 8-11 controllano il motore passo-passo ed il pin 12 viene utilizzato per ricevere 

le informazioni dal motore ad infrarossi. 

Connetteremo i 5V e la messa a terra del UNO al sensore. Per precauzione, 

utilizzeremo l’alimentazione supplementare per il motore passo-passo dato che 

utilizza molta potenza e non vogliamo rischiare di danneggiare l’alimentazione del 

UNO. 

Codice 
Dopo aver effettuato i collegamenti, naviga fino alla cartella “code” e apri il 

programma “Lesson 32 Controlling Stepper Motor With Remote”, clicca su UPLOAD 

per caricare il programma. 

Se hai dubbio riguardo all’uploading del programma o se riscontri qualche errore 

durante il caricamento torna a vedere la lezione 2. 

Prima di eseguire questo codice, controlla di aver installato le librerie < IRremote > 

e < Stepper > oppure reinstallale se necessario. Altrimenti il codice non riuscirà a 

funzionare. 

Per i dettagli su come caricare i file delle librerie, guarda la lezione 1. 

Il codice riconosce solamente due valori dal comando ad infrarossi: VOL+ e VOL-. 
Quando viene premuto il VOL+ il motore farà una rotazione completa in senso orario, 

premendo invece VOL- si avrà una rotazione in senso anti-orario. 

Foto D’esempio 
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